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About this tutorial 
In this tutorial, you will import a survey project that includes scanned data and photo 
images captured with a Trimble VX Spatial Station while surveying a material pile. Then 
you will create a surface and calculate the volume of the pile. 


Notes: 


 To add surface boundaries as described later in this tutorial, you must be running 
Trimble Business Center software with the Survey Advanced product license. To 
verify the product license for your installation, select Help > About Trimble 
Business Center and click the License button. Licensed features are displayed in 
the Features list. 


 If you need additional help at any time you are using the software, press F1 to display 
the online help. 


 


Step 1. Open the project 
For this tutorial, you will use the project file Working with Scanned Data.vce. This file 
contains a surface that you will view later in the tutorial. Otherwise, no other data has 
been imported into the project. 


1. On the Trimble Business Center menu bar, select File > Open Project. Or, click 
the Open Project icon  on the toolbar. 


2. In the Open File dialog, browse to C:\Trimble Tutorials\TBC\Projects\Working 
with Scanned Data.vce and click Open. 


If you installed the tutorial to a location other than the default location shown here, 
browse to that location. 


The project opens in the Trimble Business Center window. 


Note: This tutorial shows the Plan View with a black background. Your background 
may be white. If you want to change it to black, select Tools > Options and select 
Background color: Black in the Options dialog. 


The project file is read-only. You can perform the tutorial steps without saving the project 
file. However, if you are interrupted while performing the tutorial, you can save it by 
selecting File > Save Project As and saving it to ..\My Documents\Trimble Business 
Center, which is the typical location for storing project files on your computer. Then, you 
can re-open the project to continue the tutorial at a later time. 


You are now ready to import survey data into your project. 


Step 2. Import survey data 
In this step, you will import a JXL (.jxl) file into your project. During the import process, 
the following related files are imported along with the JXL file: 







 Step 2. Import survey data  


Trimble Business Center Tutorial – Working with Trimble VX Scanned Data 4 


 Four Trimble Scan Files (TSF) containing the scanned information from the Trimble 
VX Spatial Station 


 Numerous photo images captured with the Trimble VX during the survey 


 A Feature Definition (.fxl) file containing definitions used to record and process 
feature codes 


1. Select File > Import. Or, click the Import icon  on the toolbar. 


The Import pane opens in the right side of the Trimble Business Center window. 


2. In the Import pane, click the Browse button . 


3. Browse to C:\Trimble Tutorials\TBC\Data\Working with Scanned Data and click 
OK. 


The Working with Scanned Data folder contains the JXL job file and related files, all 
of which display in the Select File(s) list in the Import pane. 


 


4. In the Select File(s) list, select argpile144.jxl and click the Import button. 


The content of the Working with Scanned Data folder is imported into your project. 
Survey data is displayed in the Plan View. 


5. Click in the Plan View and use your mouse wheel to zoom in. Press the mouse 
wheel and move the mouse to center the points as shown here. 
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Photo images (reference images) taken during the job using the Trimble VX are 
represented by the orange lines in the Plan View. (If you zoom in, you will see these 
are actually wireframes that are used as placeholders for the images.) Scanned data 
displays as "point clouds." 


 


 


Step 3. View referenced photo images 
The imported job includes numerous referenced photo images that can be viewed on the 
Image View tab. Note that the images are located at a default pseudo-distance from the 
instrument. This is because the images themselves do not have distance information. 


You will start by verifying the default image view distance defined for your project. 


1. Select Project > Project Settings. Or, click the Project Settings icon  on the 
toolbar. 
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2. In the navigation (left) pane in the Project Settings dialog, select View > Image 
View. 


 


In some instances, modifying this distance can help to correct the alignment of 
objects between multiple images. When the objects in the images are at a distance 
greater than or less than this default distance, changing the Image View distance to 
a more realistic distance will help with the object alignment. 


However, for this tutorial you will not change the default distance. 


3. Click Cancel to close the Project Settings dialog. 


Next you will change the highlight color to make highlighted lines and point labels 
more visible in the various graphic views.  


4. To change the highlight color, do the following: 


a. Select Tools > Options. 


b. In the Options dialog, click the Browse button  for Highlight color. 


c. In the Color dialog, select bright yellow and click OK. 


 


d. In the Options dialog, click OK. 


Note: Settings in the Options dialog are not specific to a single project. They are 
kept until you change them, regardless of the project you open. If you do not want to 
keep yellow as your highlight color for other projects, you can change it at any time. 


The Options dialog includes a Cloud point size control that allows you to specify 
the pixel size of each point contained in a point cloud displayed in a graphic view. For 
this tutorial, you will leave it at the default size of 2 pixels. 
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You can click the Advanced button to display the Advanced Graphics Options 
dialog. This dialog provides options for enhancing your graphics display and 
performance when you are exploring rich data sets in the various graphic views. For 
more information on this dialog, open it and press F1. 


You are now ready to view photo images. You will start by selecting a station from 
which photos were taken. 


5. In the Plan View, do the following: 


a. Click point 102 and select Station: 102 in the context menu. 


Each station from which photos were taken is identified by a pink camera symbol 
in the Plan View. 


 


b. Right-click in the Plan View and select New Image View. 


The Image View displays showing the array of photo images taken from Station 102 
interlaced in a panoramic view.  


Notes: Depending on your computer configuration and available memory, it may take 
several moments to display the image. 
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The orange wireframes displayed on the Image View represent photo image arrays 
taken from other station setups. 


To view an array of photo images taken from a different station, you can either select 
a station (represented by a pink camera icon) or select one of the wireframes in the 
Image View. . 


6. Click one of the wireframes in the array on the right side of the photo images from 
station 102, and select Referenced Image: IMG00010.JPG in the context menu. Then 
right-click and select New Image View in the context menu. 


 


The newly selected photo image, along with other photo images in the array, displays 
centered on the Image View, outlined by a yellow box.  


 







 Step 3. View referenced photo images  


Trimble Business Center Tutorial – Working with Trimble VX Scanned Data 9 


Note that the name of the station from which the array of photo images was taken is 
displayed in the lower left corner of the Image View. 


 


Note: Viewing a large number of images can require a lot of computer memory. If 
there is inadequate memory available to display all of the images, some images will 
display only as a green wireframe on the Image View. In this case, you should close 
and reopen the Image View. 


Next you will try a different method of selecting an image to view. 


7. Click on the Image View somewhere other than on an image or wireframe so that no 
image is selected. Then select View > New Image View in the menu bar. 


The Select Image dialog displays allowing you to select any station or image in the 
project to view the image(s) on the Image View tab.  


 


8. Click Cancel to close the Select Image dialog. 


Next, you will use the View Filter Manager to change how your data is displayed. 
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Step 4. Filter the view 
1. Select View > View Filter Manager. 


 


2. Deselect the following options in the Raw Data list to see how it affects your image. 


 Referenced Frame 


 Scan Point 


 Total Station 


 


Only surveyed points are displayed. 
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3. On the Point tab in the bottom of the View Filter Manager pane, deselect the Show 
point label option. 


The surveyed points circled in the following figure are on the backside and the top of 
the material pile. Because the images do not have depth, all surveyed points in the 
project are visible in the Image View. 


 


4. Reselect the Scan Point option in the Raw Data list in the View Filter Manager 
pane. Then try viewing the data using other views: 


 Select the Plan View and use your mouse wheel to zoom out as shown here. 


 


 Select View > New 3D View and experiment with changing the perspective. 


 Use the mouse wheel to zoom in or out. 


 Press the Ctrl key and use the mouse wheel to rotate the view around the X 
axis. 


 Press the Shift key and use the mouse wheel to rotate the view around the Z 
axis.  
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 Press the Ctrl + Shift key and use the mouse wheel to exaggerate 
differences between elevations. 


 Press the Ctrl key and use the mouse wheel along with moving the mouse to 
rotate the view freely in any direction. 


 


5. Reselect the Show point labels option on the Point tab in the View Filter Manager 
pane. 


In the next two steps, you will create a surface so that you can calculate the volume of 
the materials pile. 


Step 5. Create a boundary for a surface 
The scanned points around the perimeter of the materials pile are coded with appropriate 
feature codes to create four separate feature linestrings. In this step, you will first process 
the feature codes to create the linestrings. Then you will join the four linestrings into a 
single linestring to create a boundary for the material pile. Later in the tutorial, you will 
create a surface based on this boundary, and calculate the volume of the material pile. 


For this project, the feature definitions required to process the feature codes were 
imported automatically when you imported argpile144.jxl. If they had not been, you would 
need to import a Feature Definition (.fxl) file prior to processing. 


Note: For more information on working with feature codes, see the tutorial Processing 
Feature Codes. 
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1. To make it easier to see the feature linestring you are going to create, in the View 
Filter Manager, deselect the Scan Point option in the Raw Data list. Then select the 
Plan View tab. 


 


2. Process the feature codes as follows: 


a. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 
icon  on the toolbar. 


b. In the Process Feature Codes pane, select the checkbox for argpile144.jxl and 
click the Process Source(s) button. 


After processing is complete, the Feature Codes Processing dialog displays asking 
if you want to view the Feature Code Processing Report. Click No. 
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A single line appears to connect all of the points around the perimeter of the material 
pile in the Plan View. 
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Actually, based on the feature codes assigned to the surveyed points, four feature 
linestrings were created: a longer linestring on each side of the pile in the Plan View, 
and a shorter linestring at the top and the bottom. In the following image, the two 
longer linestrings are selected (yellow). the two shorter linestrings are not selected 
(green) and are circled in red. 


 


3. To combine the four separate linestrings into a single linestring for the surface 
boundary, do the following: 


a. Select Lines > Join Lines in the menu bar. 


The Join Lines pane displays. 


 


b. Select the All selected lines option. 
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c. Click in the Lines to join field. 


d. While holding the Shift key, click each of the four linestrings in the Plan View. 


Each linestring turns yellow (highlighted) as you select it. 


e. In the Join Lines pane, click the Join button. 


The four separate linestrings are merged into a single linestring. 


4. In the View Filter Manager pane, select the Scan Point option in the Raw Data list. 


 


You are now ready to create a surface based on the new linestring boundary. 


Step 6. Create a surface 
1. Select Surface > Create Surface. 


The Create Surface pane displays. 
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2. In the Name field, enter MaterialPile. 


3. In the Surface classification drop-down list, select Stockpile. 


4. Click in the Members to form surface field. Then, in Plan View, draw a box around 
the newly created green Boundary line. 


 


5. Click OK. 
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The new MaterialPile surface is displayed in the Plan View. 


 


6. Select Surface > Add/Remove Surface Boundaries. 


The Add/Remove Surface Boundaries pane displays. 
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7. Click in the Boundaries to add or remove field. Then, in the Plan View, select the 
line created around the stockpile (Linestring: ToeDitch). 


 


8. In the Add/Remove Surface Boundaries pane, click the Add button. 


The surface is trimmed to the boundary.  


 


9. In the Add/Remove Surface Boundaries pane, click the Close button. 


10. Select the 3D View tab and view the edge of the material pile as shown in the 
following figure. 


 Use the mouse wheel to zoom in.  


 Press the Ctrl key and use the mouse wheel to rotate the view on the X axis.  


 Press the Shift key and use the mouse wheel to rotate the view on the Z axis. 
(Optionally, press the Alt key and click a location in the view  to select a new 
rotation point.)  


 Select View > 3D View Settings to display a pane that allows you to perform 
these same actions using interface controls. 







 Step 7. Remove unwanted scan points from the surface  


Trimble Business Center Tutorial – Working with Trimble VX Scanned Data 20 


Note: Your view does not have to match this one, as long as you can see the 
irregular points along the surface boundary as shown here. 


 


You can see variations in the surface around the perimeter of the surface (circled in 
green below). Most of these are the result of scan points being created based on 
measurements for weeds growing at the base of the pile. 


 


To ensure that your volume calculation is correct, you will need to remove these points 
since they do not represent the surface of the pile itself. 


Step 7. Remove unwanted scan points from the 
surface 


1. Click the MaterialPile surface on the 3D View to select it. Then right-click and select 
Add/Remove Surface Members. 
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The Add/Remove Surface Members pane displays. 


 


2. In the 3D View, draw a box around some of the points you want to remove from the 
surface. 


The number of selected points is displayed in the Members to add or remove field. 


 


3. Click the Remove button to remove the selected points. 
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The change is reflected in the 3D View. 


 


Typically you would repeat this procedure until you had removed all of the unwanted 
points. But for this tutorial, you are going to switch to a surface that was included in 
the project for which all unwanted points have already been reviewed. 


4. In the Add/Remove Surface Members pane, click Close. 


5. In the View Filter Manager, deselect MaterialPile in the Surface section of the list, 
and select MaterialPileDone. 
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The MaterialPileDone surface displays in the 3D View. Note that the surface no 
longer includes the unwanted points. 


 


You are now ready to calculate the volume of the material pile. 


Step 8. Calculate the volume of the material pile 
1. Select Reports > Earthwork Report. 


The Earthwork Report pane displays. 


 


2. Select the Stockpile/Depression option. 


3. In the Surface drop-down list, select MaterialPileDone. 


4. Click in the Boundary box, then select the Linestring: ToeDitch in the 3D View. 
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If necessary, zoom in to better see the linestring. 


 


5. In the Volume Breakdown section of the Earthwork Report pane, select the 
Volume totals only option. 


6. Click OK. 


The Earthwork Report opens in a browser window showing the volume calculation in 
the "Stockpile Volume Analysis" section. 


You are done calculating the volume of the materials pile. 


7. In the Trimble Business Center window, select File > Close Project. 


The Save Changes dialog displays. If you saved the project to a new location or with 
a new name, you can click Yes. Otherwise, click No. 


The next section explains how to use the Create Surface Edge Breakline command. 
Because the Working with Scanned Data.vce project file used for this tutorial does not 
include appropriate data to demonstrate this command, the section is explanatory only 
and does not include hands-on procedural instructions. 
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Note on using the Create Surface Edge Breakline 
command 


The Create Surface command sometimes adds triangle on the boundary where they are 
not needed, as shown here: 


 


Using the Trim Surface Edge command, you can remove these triangles. 
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However, subsequent editing of the surface can cause the triangles to be recalculated. 
To prevent the triangles from being recalculated, after trimming a surface you can use the 
Create Surface Edge Breakline command to draw a breakline around the existing 
surface parameter. 
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About this tutorial 
In this tutorial, you will process and edit feature codes that have been imported into your 
project. Then you will view feature data in the various project views, and export the 
features as a CAD drawing. 


Note: If you need additional help at any time you are using the software, press F1 to 
display the online help. 


Understanding Feature Code Processing 
When a surveyor observes a feature in the field, he can make a record of it that includes 
the type of feature (for example, a tree), along with its location and any associated 
attributes (for example, the height of the tree and a photo). He does this by selecting from 
a library of predefined feature codes imported from a Feature Definition (.fxl) file, and 
supplying attribute values as required. The feature codes, along with any associated 
photos and attribute values, can then be imported into a Trimble Business Center project 
and processed using the same feature definitions.  


After feature codes have been processed, the software can display symbols and line 
work that represent the real world objects. Features can then be exported to other 
systems (for example, CAD or GIS) as necessary. 


There are two basic types of features: 


 Point feature - A point feature is used to identify a single feature, such as tree or 
utility pole. Each point feature is assigned to a point, which specifies its location. After 
a point feature code is processed in Trimble Business Center, the resulting feature is 
typically represented by a specific symbol displayed on top of the point in the various 
graphic views. You can view and edit attribute values assigned to a point feature by 
opening the Properties pane for the point to which it is assigned. 


 Line feature - A line feature is used to identify a line, such as a fence or curb. When 
points with line feature codes are processed in Trimble Business Center, a linestring 
with feature data is created. The feature linestring can be easily edited using the Edit 
Linestring command. If offset lines are specified for the line feature, additional 
linestrings are created. The line style used for the linestring is determined by the 
feature definition used to define the line feature. You can view and edit attribute 
values assigned to a linestring feature by opening the Properties pane for the 
linestring. 


If a point or line feature includes a photo or other media file attribute, a Media Folder 
icon  is displayed with the point or linestring. You can view a media file by opening the 
appropriate Media Folder. 
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Step 1. Open the project 
For this tutorial, you will use the project file Processing Feature Codes.vce. The project 
includes data from a Cadastral survey of a city bus terminal. Integrated surveying 
methods were used to collect the field data.  


1. On the Trimble Business Center menu bar, select File > Open Project. Or, click 
the Open Project icon  on the toolbar. 


2. In the Open File dialog, browse to C:\Trimble Tutorials\TBC\Projects\Processing 
Feature Codes.vce and click Open. 


If you installed the tutorial to a location other than the default location shown here, 
browse to that location. 


The project opens in the Trimble Business Center window. 


 


Note: This figure shows the Plan View with a white background. Your background 
may be black. If you want to change it to white, select Tools > Options and select 
Background color: White in the Options dialog. 
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The project file is read-only. You can perform the tutorial steps without saving the project 
file. However, if you are interrupted while performing the tutorial, you can save it by 
selecting File > Save Project As and saving it to ..\My Documents\Trimble Business 
Center, which is the typical location for storing project files on your computer. Then, you 
can re-open the project to continue the tutorial at a later time. 


Step 2. Import the Feature Definition (.fxl) file 
Before you can process the feature codes imported into your project, you must import the 
same Feature Definition (.fxl) file that was used to assign codes in the field. There are 
three ways of doing this: 


 Use the Feature Code Processing section of the Project Settings dialog to import 
the Feature Definition (.fxl) file.  


 Use the Import pane to import the Feature Definition (.fxl) file. After import, the 
imported file is displayed in the Feature Code Processing section of the Project 
Settings dialog. 


 When you import a Job (.job) or JobXML (.jxl) file that specifies a Feature Definition 
(.fxl) file that is included in the same folder, the Feature Definition (.fxl) file is 
automatically imported into your project as well. After import, the imported file is 
displayed in the Feature Code Processing section of the Project Settings dialog. 


In this step, you will import the Feature Definition (.fxl) file created for this tutorial using 
the Project Settings dialog. 


1. Select Project > Project Settings. 


2. In the navigation (left) pane in the Project Settings dialog, select Feature Code 
Processing. 


 


3. Click the Browse button  located to the right of the Feature definition file field. 


4. In the Open  dialog, browse to C:\Trimble 
Tutorials\TBC\Data\GlobalFeaturesTutorial.fxl  and click Open. 


5. In the Project Settings dialog, click OK to close the Project Settings dialog.  


The feature definitions contained in GlobalFeaturesTutorial.fxl are imported into your 
project's Feature Definition Library to be used for feature processing. 
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However, before processing, you will take a look at the unprocessed feature codes in 
your project. 


Step 3. View unprocessed feature codes 
Before you process the feature codes in your project, you can view the codes and their 
assigned values, and make changes if necessary. 


1. Select View > Project Explorer. Or, click the Project Explorer icon  on the 
toolbar. 


The Project Explorer pane displays. 


2. In the Project Explorer pane, click the plus symbol next to the Points node. Then 
double-click point 700. 


 


The Properties pane displays on the right side of the window showing properties for 
point 700. The feature code assigned to the point displays in the Point Information 
section. 
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3. Click  in the Feature code field to view more information about the feature code in 
the Feature Code Editor dialog. 


 
This dialog allows you to remove a feature code, select a different feature code, add 
a feature code, and/or change attribute values. Note that the feature codes are 
defined in the GlobalFeaturesTutorial.fxl file.  


4. To view the photo assigned to point 700, select the photo attribute row and click the 
View File icon . 


The photo displays in your default photo viewing software. 
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5. When you are done viewing the Feature Code Editor, click Cancel to close the 
dialog. 


You are now ready to process the feature codes in your project. 


Step 4. Process feature codes 
You must process features codes to display their associated features correctly in graphic 
views and to export feature data. 


1. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 
icon  on the toolbar. 


2. In the Process Feature Codes pane, select the checkbox for rtd topo.jxl and click 
the Process Source(s) button. 


 


After processing is complete, the Feature Codes Processing dialog displays asking 
if you want to view the Feature Code Processing Report. 


3. In the Feature Codes Processing dialog, click Yes. 


The Feature Code Processing Report displays on a new tab in the Trimble 
Business Center window. 


4. Scroll to the "Unknown Feature Codes" section. 


Note that there are four points whose feature codes are unknown. This means that 
there is no corresponding feature code contained in the project's Feature Definition 
Library to process the codes. In this case, the codes were incorrectly entered in the 
field.  


Next, you will fix the unknown feature codes before reprocessing. 


Step 5. Change feature codes 
In this procedure, you will assign the correct feature code to each of the four points listed 
in the "Unknown Feature Codes" section of the Feature Code Processing Report. But, 
because codes are read-only after features have been processed in your project, you 
must remove the processing results before you can make changes to the codes.  


1. To remove feature processing results: 


a. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 
icon  on the toolbar. 
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b. In the Process Feature Codes pane, select the checkbox for rtd topo.jxl, and 
click the Remove Processing button. 


 


2. In the "Unknown Feature Codes" section of the Feature Code Processing Report, 
click point 727. 


The properties for point 727 are displayed in the Properties pane. 


 


The yellow icon  at the right in the Feature code field indicates the point has an 
unknown feature code. You can enter a new code directly in the field if you know it 
and you do not need to specify any attributes. Otherwise, you can click the  button 
to open the Feature Code Editor dialog to make the changes. For this tutorial, you 
will use both methods. 


3. Click the  button in the Feature code field. 
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The Feature Code Editor dialog displays. 


 


4. In the Feature code field, select rd and press the Delete key to remove the code. 


5. In the GlobalFeaturesTutorial.fxl list, select RB (RoadBarrier) and click the Add 
Code button. 


The code is added to the Feature code field. 


 


6. Click OK. 


The newly assigned code displays in the Feature code field in the Properties pane 
for point 727. 


 


7. Change codes for the other points displayed in the "Unknown Feature Codes" section 
of the Feature Code Processing Report. Just click each point in the report to display 
its properties in the Properties pane. 
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a. For point 728, change rd end to RB END. 


For this change, click the  button to open the Feature Code Editor dialog. 
Delete rd end from the Feature code field. Then select RB (RoadBarrier) in the 
GlobalFeaturesTutorial.fxl list and click the Add Code button. The code RB 
represents a line feature and should include the END (EndLine) line control code. 
Click the Category filter icon  and select Line Control Code to display only 
line control codes in the list. 


 


Select END in the list, and click the Add Code button.  


 


Then click OK to see the change in the Properties pane for point 728. 


 


b. For point 780, change cb 1x2m to CBI 1x2m. 


For this edit, type the change directly in the Feature code field. Note that the 
italicized text 1x2m is simply a free-form description for the code preceding it. 


 


c. For point 781, change cb inv to CBI INV. 
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Again, type the change directly in the Feature code field. 


 


You are now ready to reprocess the feature codes with the changes you made. 


Step 6. Reprocess feature codes 
1. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 


icon  on the toolbar. 


2. In the Process Feature Codes pane, select the checkbox for rtd topo.jxl and click 
the Process Source(s) button. 


After processing is complete, the Feature Codes Processing dialog displays asking 
if you want to view the Feature Code Processing Report. 


3. In the Feature Codes Processing dialog, click Yes. 


A new Feature Code Processing Report displays on a new tab in the Trimble 
Business Center window. Note that there are no longer any unknown feature codes 
listed in the report. 


You can now view the processed features. 
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Step 7. View processed features 
1. Select the Plan View tab and use your mouse wheel to zoom in to view the 


processed feature data, as shown below.  


 


To better view the features, you can choose to hide unnecessary data in the Plan 
View. 


2. Select View > View Filter Manager. 


The View Filter Manger pane displays. 


 


3. In the Raw Data list: 


 Deselect RTK Vector. 


 Deselect Total Station. 
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Point feature symbols and feature linestrings are more clearly visible in the Plan 
View. 


 


To view information about a feature, including any attribute values, you can select the 
point or linestring to which the feature is assigned.  


4. In the Plan View, click the red symbol on point 700 and select Point: 700 in the 
context menu. 


The Properties pane for point 700 displays. In the lower portion of the pane, the 
Feature section displays the processed feature name and attribute values assigned 
to the point feature. 


 


You can select a different feature or change any attribute values using these fields. If 
you select a different feature for the point and then reprocess the feature codes in 
your project, the new feature you assigned to the point is kept with the point, while 
the original feature code is used to create a "secondary" feature for the point, which 
you can select in the Plan View. 


Although you can select a different feature for a point, you cannot edit the point's 
feature code after you have processed feature codes in your project. If you needed to 
change the code, you would first have to remove the feature processing results as 
described earlier in this tutorial. 
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If a feature includes a media attribute, such as a photo, a Media Folder icon  is 
displayed next to the point, as shown here.  


 


Note: A Media Folder is attached to any point or line to which a media file is 
assigned, whether it was assigned to the point as a feature attribute or assigned 
some other way. If a media file (for example, a photo) is assigned to a point as a 
feature attribute and additional media files are assigned to the point as well, you can 
select to use one of the other media files as the feature attribute by selecting it in the 
media (for example, Photo) drop-down list in the Feature section of the Properties 
pane. 


5. In the Plan View, click the Media Folder icon for point 700 and, if necessary, select 
Media Folder: 700 in the context menu. 


The Properties pane for the Media Folder is displayed showing the media file 
assigned to the point and information associated with it. You can click the View 
button  located to the right of the media file path to view the image in your default 
photo viewing software. 


6. In the Plan View, click the line running through point 700 and, if necessary, select 
Linestring: GutterLeft in the context menu. 


This is a linestring created from line feature codes during processing. The Properties 
pane for the linestring displays showing the feature name and any feature attributes.  


You can also view the features in your project in 3D. But before you do, you will apply 
additional filters to your view to make the features easier to see. 


7. In the View Filter Manger pane: 


 In the Raw Data list, deselect Media Folder. 


 In the Layers list, deselect Points.  


 On the Point tab, deselect Show point labels. 
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 On the Point tab, select Show feature symbol only. 


 


8. Select View > New 3D View. Or, click the New 3D View icon  on the toolbar. Then 
use your mouse wheel to zoom in as shown here. 


 


9. Select View > 3D View Settings. 


The 3D View Settings pane displays. You can use the controls in this pane to 
change the 3D view of the features. 


a. In the Vertical angle field, enter 54°00'00". 
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b. In the Azimuth field, enter 25°00'00". 


 
Note that by setting the Vertical Exaggeration factor to approximately 5 (experiment 
by sliding the control right and left), you can spot the elevation bust on a curb. 


 


10. To view the feature data in Google Earth, do the following: 


a. Select View > Google Earth. 


b. In the Google Earth pane, click the Options button and select Select All. 


 


c. Click the Apply button. 
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Points, feature lines, and camera icons are displayed in Google Earth. You can click 
any camera icon to display the associated image. 


 


Next, you will export the processed feature data as a CAD drawing file. 


Step 8. Export as a CAD drawing 


1. Select File > Export. Or, click the Export icon  in the toolbar. 


2. In the Export pane, select the CAD tab. 


 


3. On the CAD tab, select DWG exporter in the list at the top of the tab. 


4. In the Data section, click the Options button and select Select All. 


5. Click the Export button to create the CAD drawing (.dwg) file and save it to your 
project folder. 
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You are done working with feature codes. 


6. Select File > Close Project. 


The Save Changes dialog displays. If you saved the project to a new location or with 
a new name, you can click Yes. Otherwise, click No. 
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Acerca de este tutorial 
En este tutorial, ajustará la red para un proyecto que contiene datos GNSS, de estación 
total y de nivel. 


Notas: 


 Para realizar un ajuste de red en datos combinados GNNS, de estación total y de 
nivel como se describe en este tutorial, debe tener en ejecución el software Trimble 
Business Center con la licencia de producto Survey Advanced. Para comprobar la 
licencia de producto para su instalación, seleccione Ayuda > Acerca de Trimble 
Business Center y haga clic en el botón Licencia. Las funciones con licencia se 
muestran en la lista Funciones. 


 Si en cualquier momento necesita ayuda adicional mientras utiliza el software, 
presione F1 para ver la ayuda en línea. 


 


Paso 1. Abrir un proyecto. 
Para este tutorial, usará el archivo de proyecto Adjusting the Network.vce. Ya importaron 
GNSS, estación total y datos de nivel al proyecto y se procesaron las líneas base GNSS. 


1. En la barra de menú de Trimble Business Center, seleccione Archivo > Abrir 
proyecto. O haga clic en el icono Abrir proyecto  en la barra de herramientas. 


2. En el diálogo Abrir archivo, vaya a C:\Trimble Tutorials\TBC\Projects\Adjusting 
the Network.vce y haga clic en Abrir. 


Si instaló el tutorial en una ubicación distinta a la predeterminada que se muestra 
aquí, navegue hasta esa ubicación. 
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El proyecto se abre en la ventana de Trimble Business Center. 


 


Nota: Esta figura muestra la ficha Vista de plano con un fondo blanco. Su fondo 
puede estar en negro. Si desea cambiarlo a blanco, seleccione Herramientas > 
Opciones y seleccione Color de fondo: Blanco en el diálogo Opciones. 


El archivo de proyecto es de sólo lectura. Puede realizar los pasos del tutorial sin 
guardar el archivo del proyecto. Sin embargo, si sufre una interrupción mientras sigue el 
tutorial, puede guardarlo al seleccionar Archivo > Guardar proyecto como y guardarlo 
en ..\Mis documentos\Trimble Business Center, que es la ubicación típica para 
guardar archivos de proyectos en su computadora. Tras ello, puede volver a abrir el 
proyecto para proseguir con el tutorial más adelante. 


Antes de ajustar la red en su proyecto, debe hacer algunos cambios a la configuración 
de su proyecto. 


Paso 2. Modificar la configuración del proyecto 
En este paso, seleccionará las fuentes a utilizar para errores estándar predeterminados. 
Luego, especificará los errores estándar predeterminados para datos de estación total, 
nivelación y GNSS. 


1. Seleccione Proyecto > Configuraciones del proyecto. O haga clic en el icono 
Configuraciones del proyecto  en la barra de herramientas. 
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2. En el panel de navegación (izquierdo) del diálogo Configuraciones del proyecto, 
seleccione Ajuste de red > General. Luego seleccione Usar mediana de 
observaciones en la lista desplegable Ángulos medios. 


 


3. En el panel de navegación, seleccione Errores estándar por defecto. Luego 
seleccione opciones de la manera siguiente: 


 Estación total: 
- Fuente de errores estándar: Archivos importados 
- Fuente para errores de centrado: Configuraciones del proyecto 


 Nivelación: 
- Fuente para errores estándar: Configuraciones del proyecto 


 GNSS: 
- Fuente para errores estándar: Procesador de líneas base 


 Acimut: 
- Fuente para errores estándar: Configuraciones del proyecto 


4. En el panel de navegación, seleccione Errores estándar por defecto > Estación 
total. Luego seleccione opciones de la manera siguiente: 


 Errores estándar por defecto: 
- Ángulo horizontal: 0°00'05" 
- Ángulo vertical: 0°00'05" 


 Errores de centrado por defecto: 
- Error de centrado del instrumento: 0,002 m 
- Error de centrado del destino: 0,002 m 


 Errores de altura por defecto: 
- Error en altura del instrumento: 0,002 m 
- Error en altura del destino: 0,002 m 


5. En el panel de navegación, seleccione Errores estándar por defecto > Nivelación. 
Luego seleccione opciones de la manera siguiente: 


 Errores estándar por defecto: 
- Error estándar sobre 1 km de doble nivelación: 0,0 mm 
- Error estándar para cada instalación de estación: 3,0 mm 


6. En el panel de navegación, seleccione Errores estándar por defecto > GNSS. 
Luego seleccione opciones de la manera siguiente: 


 Errores de configuración predeterminados: 
- Error en altura de antena: 0,002 
- Error de centrado: 0,005 
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7. Haga clic en Aceptar para cerrar el diálogo Configuración del proyecto. 


Ahora está preparado para realizar un ajuste de red. Lo hará siguiendo un proceso de 
dos pasos. Primero, realizará un ajuste de red mínimamente restringido. Tras ello, 
realizará un ajuste de red restringido. 


Paso 3. Realizar un ajuste de red mínimamente 
restringido 


Para evaluar la consistencia interna de la red de levantamientos, primero debe realizar 
un ajuste de red mínimamente restringido, que usa la cantidad mínima de restricciones 
requeridas para definir el sistema de coordenadas. 


1. Seleccione Levantamiento > Ajustar red. 


Aparecerá el panel Ajustar red. 


 


Hay 13 puntos de control basados en la ficha Fijos. Diez son los puntos de control 
verticales procedentes de los datos de nivel DiNi y la hoja de datos: 


 B412 


 barbara 


 ENERGY 


 F 408 


 flange 


 hard 


 Jeffco AZ MK 


 Jeffco Reset 


 Jeffco Reset 


 sixtwo 


Tres son puntos de control horizontal procedentes de la hoja de datos CORS 
(Estaciones de Referencia en Operación Continua): 


 P041 


 PLTC 
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 TMGO 


Para este proyecto, realizará un ajuste mínimamente restringido: fijará la estación 
P041 en 2D y h. 


2. En la ficha Coordenadas fijas, seleccione las casillas 2D y h para P041. 


 


3. Haga clic en el botón Ajustar. 


Aparecerá un mensaje que le preguntará si desea resolver los errores de cálculos 
del proyecto. Haga clic en el botón Sí para continuar con el ajuste de red sin resolver 
los errores. 


En la ficha Resultados del panel Ajustar red aparecerá un resumen de los 
resultados del ajuste. 


 


El Factor de referencia es 1.35, los Grados de libertad son 268 y la prueba de Chi 
al cuadrado arrojó un Resultado fallido. Esto quiere decir que es posible que se 
haya indicado algunos vectores como valores apartados en el ajuste y/o que es 
necesario aplicar una estrategia de ponderación en los vectores procesados. 


4. En el panel Ajustar red, haga clic en el icono Informe . 


Aparecerá el Informe de ajuste de red en la ventana del navegador. Para navegar a 
través de las secciones del informe, haga clic en los vínculos del panel de 
navegación que se encuentra en el lado izquierdo del informe o use el ratón para 
avanzar a lo largo del mismo. 


5. Revise el informe, especialmente las secciones "Observaciones": 
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Las observaciones con un residual estandarizado que no cumplan los criterios Tau 
aparecerán en rojo. Estas observaciones son valores apartados. En este caso, los 
vectores posprocesados TMGO --> PLTC (PV135) y filtro --> 5 (PV22) están 
indicados como valores apartados (texto en rojo) en la sección "Observaciones GPS 
ajustadas".  


 


Nota: El software asigna automáticamente un número entre paréntesis a cada 
conjunto de observaciones. Los números de su informe pueden ser distintos de los 
números que se muestran arriba. 


Ya que el nivel de redundancia de la red es alto, puede desactivar TMGO --> PLTC 
(PV135) y filtro --> 5 (PV22) y luego reajustar la red. 


6. En el Informe de ajuste de red, haga clic en el vínculo TMGO --> PLTC (PV135) de 
la sección "Observaciones GPS ajustadas". 


Esto seleccionará el vector en el proyecto. 


7. En la ventana Trimble Business Center, haga clic con el botón secundario en la 
Vista de plano y seleccione Propiedades en el menú de contexto. 


Aparecerá el panel Propiedades y mostrará TMGO --> PLTC (PV135). 
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Nota: si hace clic en cualquier otro lugar de la ventana antes de hacer clic con el 
botón secundario en la Vista de plano, el vector ya no estará seleccionado. 


8. En la lista desplegable Estado, seleccione Deshabilitado. 


Aparecerá el mensaje Borrar ajuste, el cual preguntará si desea conservar o borrar 
los resultados del ajuste de red que se realizó anteriormente.  


9. En el diálogo Borrar ajuste, haga clic en el botón Borrar ajuste. 


10. Repita los pasos 6 a 8 para el vector filtro --> 5 (PV22)  


Después de deshabilitar TMGO --> PLTC (PV135) y filtro --> 5 (PV22) podrá repetir 
el proceso de ajuste de red. 


11. Seleccione Levantamiento > Ajustar red. Luego, haga clic en el botón Ajustar para 
repetir el ajuste de red mínimamente restringido. 


Aparecerá un mensaje que le preguntará si desea resolver los errores de cálculos 
del proyecto. Haga clic en el botón Sí para continuar con el ajuste de red sin resolver 
los errores. 


En la ficha Resultados del panel Ajustar red aparecerá un resumen de los 
resultados del ajuste. 


 


12. Haga clic en el icono Informe para ver el Informe de ajuste de red. 


La prueba de Chi al cuadrado sigue arrojando un resultado fallido, por lo que será 
necesario aplicar una estrategia de ponderación en los vectores procesados. La 
aplicación de una estrategia de ponderación mejorará las estimaciones de errores a 
priori para las observaciones. Los errores a priori son los errores estimados para las 
observaciones antes de que se lleve a cabo un ajuste de la red. 
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13. En el panel Ajustar red, seleccione la ficha Ponderación. 


 


En la sección Vectores posprocesados, el factor de referencia para la red que 
aparece en el cuadro de la izquierda es 1.04. El objetivo es llegar a un factor de 
referencia de 1.0. 


14. En las secciones Vectores posprocesados, Ángulos horizontales, Ángulos 


verticales, Distancias de pendiente y Nivelación, haga clic en para aplicar un 
escalar en los errores estimados. 


El software calcula un nuevo escalar de acuerdo con el factor de referencia para la 
red del último ajuste. Este escalar se aplica en errores iniciales estimados de todos 
los vectores posprocesados en el ajuste. 


Ahora, está preparado para recalcular el ajuste mínimamente restringido. 


15. Haga clic en el botón Ajustar 


Aparecerá un mensaje que le preguntará si desea resolver los errores de cálculos 
del proyecto. Haga clic en el botón Sí para continuar con el ajuste de red sin resolver 
los errores. 


Aparecerá la ficha Resultados en el panel Ajustar red. 


 


Ahora, el Factor de referencia para la red es .97 y la prueba de Chi al cuadrado 
arroja un resultado Aprobado. Las estimaciones de errores a priori coincide con los 
errores ajustados de los vectores de la red.  


Ahora, está preparado para realizar un ajuste de red restringido. 
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Paso 4. Realizar un ajuste de red restringido 
En este paso, realizará un ajuste restringido en el cual los puntos de control restantes se 
fijan a las coordenadas de las hojas de datos importadas. El objetivo es calcular las 
coordenadas ajustadas de los puntos medidos en la red de levantamiento, en relación 
con las estaciones de control existentes. 


Las estaciones de este levantamiento son de diversa calidad de levantamiento, como por 
ejemplo: 


 calidad CORS (Estaciones de Referencia en Operación Continua) 


 distintas calidades a partir de estaciones nacionales de referencia de red  


 calidad de observaciones DINI ajustadas  


Puede asignar valores de error estándar a cada punto de control de acuerdo con su 
calidad, usando valores ajustados en levantamientos anteriores o estimaciones de 
errores de ajustes de ajustes de estaciones CORS o de estaciones nacionales de 
referencia de red. Al asignar un error estándar a un punto de control, permite que se 
ajuste el valor de la coordenada del punto de control según la calidad de las 
observaciones y los otros puntos de control. 


Si decide no asignar valores de error estándar, se asignará un valor fijo de 0,000001m 
(micrómetro) a cada punto, independientemente de la calidad del mismo. 


Para este tutorial, escribirá valores fijos para las estaciones, estimaciones de precisión 
de las hojas de datos de la Oficina Geodésica Nacional (NGS), junto con algunos valores 
supuestos para los puntos de control de menor precisión. 


1. En el panel Ajustar red, seleccione la ficha Coordenadas fijas. Luego, haga clic en 
el icono Usar ponderación asignada  en la parte superior del panel. 


En lugar de la ficha Coordenadas fijas, aparecerá la ficha Coordenadas limitadas. 


 


Ahora, puede expandir cada punto de control para introducir estimaciones de errores 
estándar. Para este tutorial, introducirá los valores norte y este de las estimaciones. 
(Si están disponibles, puede introducir los valores horizontales). Sin embargo, antes 
de hacerlo, deberá realizar algunos cambios en las configuraciones del proyecto. 


2. Seleccione Proyecto > Configuraciones del proyecto y haga lo siguiente:  
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a. Seleccione Unidades > Coordenada y seleccione Sí en la lista desplegable 
Expandir errores horizontales estándar. 


 


b. Seleccione Unidades > Distancia y seleccione 0.1234 en la lista desplegable 
Precisión decimal. 


c. Haga clic en Aceptar para cerrar el diálogo Configuración del proyecto. 


3. En la ficha Coordenadas fijas del panel Ajustar red, haga lo siguiente: 


a. Haga clic en el signo "más" para expandir B412. Luego, introduzca 0.0100 m en 
el campo Elevación. 


b. Haga clic para expandir barbara e introduzca: 
0.0074 m en el campo Norte  
0.0057 m en el campo Este  
0.0294 m en el campo Alto  


 


Por lo general, también tendría que introducir estimaciones de errores para el resto 
de los puntos. Sin embargo, para este tutorial, ya se han introducido los valores 
adicionales. 


Las estimaciones de errores que se ingresan para un punto sólo se usan en el ajuste 
si selecciona una o más de las casillas "fijar" del punto, lo que lo transforma en un 
punto limitado. 


Si bien en la práctica es más común añadir sólo un punto de control a la vez, para 
este tutorial completará el ajuste limitado en dos pasos. Primero, limitará las 
coordenadas geodésicas locales NAD83 para los tres puntos de control horizontales. 
Luego, añadirá las limitaciones de elevación para la elevación de control de Trimble 
DiNi. 


Tome en cuenta lo siguiente: 


 Los valores locales (2D y h) se refieren a las coordenadas geodésicas locales 
NAD83 (latitud, longitud y altura elipsoidal) importadas desde las hojas de datos. 


 Los valores de cuadrícula (e) se revieren a las elevaciones NAVD88 importadas 
desde la hoja de datos o los archivos de nivel digital ajustados. 
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Para este tutorial, limitará algunos puntos usando las coordenadas geodésicas 
locales. Posteriormente, añadirá limitaciones de elevación. 


4. Contraiga los nodos de puntos expandidos y, para seleccionar las limitaciones del 
ajuste, seleccione las casillas 2d y h de los siguientes puntos: 


 hard 


 P041 (debiera estar marcado) 


 PLTC  


 TMGO 


 


5. Haga clic en el botón Ajustar. 


Aparecerá un mensaje que le preguntará si desea resolver los errores de cálculos 
del proyecto. Haga clic en el botón Sí para continuar con el ajuste de red sin resolver 
los errores. 


Se mostrará la ficha Resultados. 


 


Por lo general, ahora corresponde revisar el Informe de ajuste de red. De acuerdo 
con la revisión, es posible que decida seleccionar otros puntos de control 
horizontales adicionales. Para este tutorial, continuará sin seleccionar más puntos de 
control horizontales. 


A continuación, limitará sólo las coordenadas 2D de los tres puntos de control 
horizontales. Además, añadirá las elevaciones de puntos de referencia como 
limitaciones verticales. De esta manera, la red estará limitada horizontalmente por 
las coordenadas geodésicas locales NAD83 y verticalmente por las elevaciones de 
puntos de referencia NAVD88, de acuerdo con las mediciones del nivel DiNi. 
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6. En la ficha Coordenadas fijas, quite la selección de la casilla h en cada uno de los 
cuatro puntos locales: 


 hard 


 P041 


 PLTC 


 TMGO 


De esta manera, se eliminan las limitaciones de altura elipsoidal que añadió 
anteriormente. 


7. Seleccione la casilla e para los puntos de cuadrícula: 


 B 412 


 F 408 


 sixtwo 


De esta manera, se añade la elevación de punto de referencia para el ajuste. 


8. Haga clic en el botón Ajustar. 


Aparecerá un mensaje que le preguntará si desea resolver los errores de cálculos 
del proyecto. Haga clic en el botón Sí para continuar con el ajuste de red sin resolver 
los errores. 


Se mostrará la ficha Resultados. 
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9. En la barra de herramientas de la ventana Trimble Business Center, haga clic en el 
icono Acercar  según sea necesario para agrandar la vista, como se muestra 
aquí. Si lo prefiere, haga clic en la Vista de plano y use la rueda del ratón para 
acercarse. Presione la rueda del ratón y muévalo para centrar los puntos. 


 


Las elipses de error se muestran en rojo. 


10. En el panel Ajustar red, haga clic en el icono Informe  y revise la sección 
"Coordenadas de cuadrícula ajustadas". 


Esta sección del informe ilustra qué coordenadas se mantuvieron fijas en el ajuste. 
Todas las coordenadas, excepto los puntos de control, tienen errores estimados. 
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La ficha Resultados en el panel Ajustar red muestra los errores y los residuales de 
uno o más puntos, observaciones o vectores posprocesados que se haya 
seleccionado. En la Vista de plano, cree un cuadro alrededor de los elementos que 
desee ver para seleccionarlos. Su selección se mostrará en la ficha Resultados. 


 


Acaba de finalizar con el ajuste de la red. A continuación, importará datos adicionales a 
su proyecto ajustado. 


Paso 5. Importar datos adicionales al proyecto 
ajustado 


Si los datos de trabajo adicionales que desea importar incluyen las mismas IDs de 
puntos de su proyecto ajustado, puede seleccionar que las nuevas coordenadas se 
basen en los valores de las coordenadas ajustadas. En este caso, importará un nuevo 
archivo de datos que incluye una poligonal desde el punto 5 al punto frey, los cuales ya 
existen en su proyecto ajustado. 


1. Seleccione Archivo > Importar .O haga clic en el icono Importar  en la barra de 
herramientas. 
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El panel Importar se abre en el lado derecho de la ventana de Trimble Business 
Center. 


 


2. En el panel Importar, haga clic en el botón Examinar . 


3. En el diálogo Examinar carpeta, navegue hasta C:\Trimble 
Tutorials\TBC\Data\Adjusting the Network y haga clic en Aceptar. 


4. En la lista Seleccionar archivo(s), seleccione 53frey.jxl y haga clic en el botón 
Importar. 


Debido a que el software detecta una diferencia entre el sistema de coordenadas 
especificado en el proyecto y el sistema de coordenadas especificado en el archivo 
importado, aparece el diálogo de mensaje Sistema de coordenadas del proyecto. 


5. Seleccione la opción Conservar la definición del proyecto actual en el mensaje 
Sistema de coordenadas del proyecto. Luego, haga clic en Aceptar. 


Aparecerá el mensaje Borrar ajuste y preguntará si se desea conservar el ajuste de 
red que acaba de completar. Para este tutorial, conservará el ajuste después de 
importar los datos nuevos. 


6. En el diálogo Borrar ajuste, haga clic en el botón Conservar ajuste. 


Los nuevos datos se importarán de acuerdo con los valores de las coordenadas de 
los puntos 5 y frey que se calcularon en el ajuste de red. 
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En la barra de herramientas de la ventana Trimble Business Center, puede hacer 
clic en el icono Acercar (o usar la rueda del ratón) según sea necesario para 
agrandar la vista, como se muestra aquí, y ver la nueva poligonal importada. 


 


7. Seleccione Ver > Explorador del proyecto. Luego, en el panel Explorador del 
proyecto, haga clic derecho en Puntos > frey y seleccione Informe de derivación 
de puntos. 


El Informe de derivación de puntos aparecerá en una ventana del navegador. 


El informe muestra el valor en el cual se estableció el punto frey. En este caso, es el 
valor ajustado de la red. También puede ver el valor de la coordenada en el archivo 
53frey.jxl. 


Acaba de finalizar con el ajuste de la red. 


8. En la ventana Trimble Business Center, seleccione Archivo > Cerrar proyecto. 


Aparecerá el diálogo Guardar cambios. Si guardó el proyecto en una nueva 
ubicación o con otro nombre, puede hacer clic en Sí. De lo contrario, haga clic en 
No. 
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Acerca de este tutorial 
En este tutorial, importará dos archivos de datos capturados con un nivel Trimble DiNi a 
un proyecto que ya contiene datos GNSS. 


Nota: Si en cualquier momento necesita ayuda adicional mientras utiliza el software, 
presione F1 para ver la ayuda en línea. 


Paso 1. Abrir un proyecto. 
Para este tutorial, usará el archivo de proyecto Importing Digital Level Data.vce. Los 
datos GNSS ya fueron importados al proyecto, y las líneas base GNSS fueron 
procesadas. 


1. En la barra de menú de Trimble Business Center, seleccione Archivo > Abrir 
proyecto. O haga clic en el icono Abrir proyecto  en la barra de herramientas. 


2. En el diálogo Abrir archivo, vaya a C:\Trimble Tutorials\TBC\Projects\Importing 
Digital Level Data.vce y haga clic en Abrir. 


Si instaló el tutorial en una ubicación distinta a la predeterminada que se muestra 
aquí, navegue hasta esa ubicación. 
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El proyecto se abre en la ventana de Trimble Business Center. 


 


Nota: Esta figura muestra la Vista de plano con un fondo blanco. Su fondo puede 
estar en negro. Si desea cambiarlo a blanco, seleccione Herramientas > Opciones 
y seleccione Color de fondo: Blanco en el diálogo Opciones. 


El archivo de proyecto es de sólo lectura. Puede realizar los pasos del tutorial sin 
guardar el archivo del proyecto. Sin embargo, si sufre una interrupción mientras sigue el 
tutorial, puede guardarlo al seleccionar Archivo > Guardar proyecto como y guardarlo 
en ..\Mis documentos\Trimble Business Center, que es la ubicación típica para 
guardar archivos de proyectos en su computadora. Tras ello, puede volver a abrir el 
proyecto para proseguir con el tutorial más adelante. 


Antes de importar datos digitales de nivel a su proyecto, seleccionará un error estándar 
por defecto para usar para los datos. 


Nota: Puede cambiar el error estándar por defecto para un proyecto en cualquier 
momento. Sin embargo, para aplicar los cambios debe abrir y cerrar el diálogo Editor de 
niveles como se describe más adelante en este tutorial. 


Paso 2. Seleccione un error estándar por defecto 
En este paso, seleccionará los errores estándar por defecto en su proyecto, y verificará 
el valor por defecto que se usará para calcular el error estándar aplicado a las 
observaciones en el Editor de niveles. 
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1. Seleccione Proyecto > Configuraciones del proyecto. O haga clic en el icono 
Configuraciones del proyecto  en la barra de herramientas. 


2. En el panel de navegación (izquierdo) del diálogo Configuraciones del proyecto, 
seleccione Errores estándar por defecto. 


3. En la sección Nivelación, seleccione Configuraciones del proyecto en la lista 
desplegable Fuente para errores estándar. 


 


Esto garantiza que el valor del error estándar que usted especifique en 
Configuraciones del proyecto (como se describe en los próximos dos pasos) se 
use para calcular el error estándar aplicado a las observaciones en el Editor de 
niveles. 


Nota: Como alternativa, puede seleccionar usar un valor de error estándar 
especificado en el archivo de datos y que aparezca en un campo editable en el 
diálogo Editor de niveles durante la importación. Esto sería útil si, por ejemplo, 
usted estuviera importando datos de nivel de varios instrumentos DiNi con 
precisiones que difieren y quisiera editar el error estándar de cada uno durante la 
importación. Sin embargo, para este tutorial, usará el valor Configuraciones del 
proyecto. 


4. En el panel de navegación del diálogo Configuraciones del proyecto, seleccione 
Errores estándar por defecto > Nivelación. 


5. En el campo Error estándar por defecto en 1 km de doble nivelación, ingrese 0,7 
mm. 
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Asegúrese de que el campo Error estándar por defecto para cada configuración 
de estación contenga el valor 0,0 mm. Si los valores están especificados en ambos 
campos, los errores estándar para nivelación usarán la combinación de estos dos 
valores para calcular los errores estándar para las observaciones. 


 


6. Haga clic en  Aceptar. 


Terminó de cambiar las configuraciones del proyecto y ya está listo para importar datos 
digitales de nivel en su proyecto. 


Paso 3. Importar el primer archivo de datos digitales 
de nivel 


Para este tutorial, importará dos archivos de datos digitales de nivel. Para el primer 
archivo de datos, el cual contiene varias ejecuciones de nivel, usted combinará las 
ejecuciones, renombrará y quitará la selección de puntos y ajustará las ejecuciones 
antes de importar. Para el segundo conjunto de datos, que contiene una ejecución de 
nivel simple, importará los datos sin ajustarlos. 


1. Seleccione Archivo > Importar .O haga clic en el icono Importar  en la barra de 
herramientas. 


El panel Importar se abre en el lado derecho de la ventana de Trimble Business 
Center. 


 


2. En el panel Importar, haga clic en el botón Examinar . 
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3. En el diálogo Examinar carpeta, navegue hasta  C:\Trimble 
Tutorials\TBC\Data\Importing Digital Level Data y haga clic en Aceptar. 


El contenido de la carpeta Importar datos digitales de nivel  aparece en la lista 
Seleccionar archivos(s) en el panel Importar. 


4. En la lista Seleccionar archivo(s), seleccione B412.DAT y haga clic en el botón 
Importar. 


Aparecerá el diálogo Editor de niveles. 


 


Este diálogo le permite revisar los datos de nivel que esté importando y hacer 
cambios según sea necesario. Se muestra la suma de las distancias BS y FS, por lo 
que puede comprobar que se cumpla el equilibrio de distancias de la observación. 


El archivo de datos de nivel importado contiene seis ejecuciones de nivel distintas 
que componen tres dobles ejecuciones. En el diagrama de abajo se muestra cómo 
se conectan las ejecuciones. 
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Su primer paso es combinar ejecuciones de nivel, de modo que el Editor de niveles 
pueda calcular fallas de cierre. 


Paso 4. Combinar ejecuciones de nivel. 
En el archivo B412.dat, el punto B412 es el único punto que tiene una elevación de 
control ingresada (vea la figura de abajo). 


Para que el Editor de niveles calcule fallas de cierre, una ejecución debe comenzar y 
terminar en el mismo punto, o comenzar y terminar en dos elevaciones de punto de 
control. Estas ejecuciones de nivel comienzan o finalizan en un punto de referencia, o 
comienzan o finalizan en puntos desconocidos. En todos estos casos, no se calculan 
fallas de cierre para las ejecuciones. 


 


Nota: Sería aceptable importar datos de nivel al proyecto sin combinar ejecuciones de 
nivel o sin fallas de cierre. Todos los datos se combinarían para reflejar el levantamiento 
tal como se ejecutó. También podría realizar un ajuste de cuadrados mínimos en el 
Editor de niveles sin combinar las ejecuciones. Sin embargo, combinar ejecuciones de 
nivel proporciona una buena manera de comprobar la calidad de los datos y ayuda a 
detectar errores crasos y de gran magnitud. 


Para este tutorial, usará el Editor de niveles para combinar ejecuciones. Tenga en 
cuenta que para combinar dos ejecuciones de nivel, el punto de término de la primera 
ejecución debe ser el primer punto de la segunda ejecución. 


1. En el diálogo Editor de niveles, haga clic en el botón Combinar ejecuciones 
ubicado en la esquina inferior derecha del diálogo. 
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Aparecerá el diálogo Combinar ejecuciones. 


 


2. Para combinar ejecuciones, haga lo siguiente: 


a. En el campo Nombre de nueva ejecución, escriba 15. 


b. En la lista Comenzar con nombre de ejecución, seleccione 1, que termina con 
el punto flange. 


c. En la lista Agregar este nombre de ejecución, seleccione 5, que comienza con 
el punto flange. 


d. Haga clic en Aceptar. 


Las fichas Ejecución del diálogo Editor de niveles muestran cómo las ejecuciones 
1 y 5 se han combinado en una nueva ejecución 15. 
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Nota: En el diálogo Editor de niveles, puede hacer en el botón Restablecer 
ubicado en el área inferior derecha para deshacer los cambios que haya hecho al 
archivo durante la sesión de edición. Sin embargo, una vez que haga cambios y 
haga clic en Aceptar, se guardarán estos cambios, incluidas las ejecuciones 
combinadas. Si vuelve a abrir el diálogo Editor de niveles para este archivo 
después de la importación, hacer clic en el botón Restablecer no deshará los 
cambios que haya hecho en la sesión de edición anterior. Si cometió errores durante 
la sesión de edición anterior, puede eliminar el archivo del área Explorador del 
proyecto > Archivos importados y luego reimporte el archivo. 


3. Repita el procedimiento de combinación para combinar ejecuciones de la manera 
siguiente:  


a. Combine las ejecuciones 6 y 2 para convertirlas en una nueva ejecución 62. 


b. Combine las ejecuciones 15 y 62 para convertirlas en una nueva ejecución 1562. 


c. Combine las ejecuciones 3 y 4 para convertirlas en una nueva ejecución 34. 


Para cada ejecución combinada, se muestra una falla de cierre, lo que le permite 
determinar si las ejecuciones han cumplido sus requisitos. 


 


 


Paso 5. Renombrar puntos y quitar la selección de los 
mismos 


En Ejecución 1562 puede ver puntos con una marca amarilla junto a su ID. Esto indica 
que el punto se usa en otras ejecuciones dentro de este archivo. 
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El Editor de niveles hace una búsqueda en el archivo para detectar puntos que hayan 
sido nombrados automáticamente por el nivel DiNi de Trimble y que hayan recibido 
nombres únicos por parte del topógrafo. Esta es la razón de que algunos puntos se 
marquen para creación en Trimble Business Center y otros no. 


 


Si uno de estos puntos cuyo nombre ha sido asignado por DiNi un punto que es similar a 
la convención de nombres DiNi ha de ser creado, puede marcar la casilla junto a ID de 
punto para crear el punto en el proyecto.  


En este archivo, algunas de las ID de punto deben renombrarse debido a la cantidad de 
caracteres en la ID de punto permitidos por el DiNi. En tales casos, es necesario 
renombrar los puntos para que coincidan con puntos que ya existen en el proyecto. 


1. Seleccione la ficha Ejecución 1562  y cambie las ID de punto para cada uno de los 
puntos siguientes, haciendo clic en el campo ID de punto y escribiendo el nuevo 
nombre: 


 Cambie jeffcoaz a jeffco az mk. 


Puesto que este punto tiene otras observaciones en esta ejecución, aparecerá 
un mensaje preguntando si desea renombrar o no todas las observaciones. 
Seleccione Sí. 


 Cambie jeffco r a jeffco reset. 


Puesto que este punto se observa nuevamente sólo como la referencia para la 
siguiente instalación, no aparece ningún mensaje preguntando si desea 
renombrar o no todas las observaciones. 


 Cambie A412 res a A 412 reset. 


En Ejecución 34 hay varios puntos seleccionados para su creación en el proyecto, 
pero no es necesario crearlos. Puede quitar la selección de los mismos, como se 
explica en el paso siguiente. 


2. Seleccione la ficha Ejecución 34 y quite la selección de los siguientes puntos en la 
columna Crear: 


 HYD1 


 thing 


 HYD2 


 HYD3 


Ahora está listo para ajustar ejecuciones de nivel e importar los datos. 
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Paso 6. Ajustar ejecuciones de nivel e importar los 
datos 


Observe que se han calculado las fallas de cierre para Ejecución 1562 y Ejecución 34. 


 


 


Podría importar estos datos utilizando las elevaciones brutas y luego usando el comando 
Ajustar red en Trimble Business Center para ajustar los errores en los datos. Sin 
embargo, para efectos de este tutorial usará los puntos establecidos por DiNi como 
puntos de control vertical para un ajuste de red, por lo que debe ajustar las ejecuciones 
en el Editor de niveles. 


1. Haga clic en el botón Ajustar ejecuciones, ubicado en el área inferior derecha del 
diálogo. 


Aparecerá el diálogo Ajustar ejecuciones. De manera predeterminada, ambas 
ejecuciones están seleccionadas para su ajuste. 


 


2. Haga clic en  Aceptar.  
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Se realiza un ajuste de cuadrado mínimos a los datos. Para cada punto, se muestra 
la corrección y elevación ajustada en el diálogo Editor de niveles. 


 


Ahora puede usar estas elevaciones ajustadas cuando realice un ajuste de red para 
ajustar los otros datos del proyecto. 


3. En el cuadro Opciones de creación en el área inferior del diálogo Editor de 
niveles, seleccione la opción Impedir más ajustes. 


 


Esto hará que cada punto se cree con una elevación de calidad de Control. Sólo se 
importará la elevación de calidad de Control, no la observación. Para el ajuste de 
red, estos puntos estarán en la lista Coordenadas fijas y se podrán elegir para ser 
utilizados como puntos fijos. 


Si hubiera seleccionado la opción Permitir ajuste de red, cada punto se crearía con 
calidad de Control y se crearían las observaciones de elevación de incremento 
acumuladas entre los puntos. 


4. Haga clic en Aceptar para importara su proyecto el archivo de datos de nivel 
ajustados. 


5. Para ver los datos digitales de nivel recién ajustados en el Explorador del proyecto.  


a. Seleccione Ver > Explorador del proyecto. 


b. En el Explorador del proyecto, haga clic en el símbolo más que precede a 
Archivos importados 
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c. Avance hasta B412.DAT, haga clic con el botón secundario en el nombre del 
archivo y seleccione Expandir en el menú de contexto. 


 


Ahora está listo para importar el segundo archivo de datos digitales de nivel requerido 
para este proyecto. 


Paso 7. Importar el segundo archivo de datos digitales 
de nivel 


Para este paso, importará un archivo de datos de nivel con sólo una ejecución de nivel. 
Se trata de un ciclo que comienza en el punto sixtwo El topógrafo supuso una elevación 
de 100.000 cuando inició la ejecución. El punto sixtwo fue uno de los puntos de control 
establecidos por los datos de nivel B412.DAT. Puesto que los puntos en esas 
ejecuciones se guardaron como puntos de control, puede usar esas elevaciones para 
establecer elevaciones en esta ejecución. Para que pueda seleccionarlo aquí, el punto 
debe tener una elevación con calidad de Control. 


En "Paso 3. Importar el primer archivo de datos digitales de nivel", importó los datos 
utilizando el comando Importar. Para este paso, va a usar un método diferente para 
importar datos: "arrastrar y soltar". 


1. En Windows, Seleccione Inicio > Mi PC y navegue hasta C:\Trimble 
Tutorials\TBC\Data\Importing Digital Level Data. 


2. En la carpeta Importar datos digitales de nivel (Importing Digital Level Data), haga 
clic en el archivo SIXTWO.DAT en la Vista de plano en la ventana Trimble 
Business Center. 
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Aparecerá el diálogo Editor de niveles. 


 


3. En el campo Tipo de elevación para el punto sixtwo, seleccione Coordenada en la 
lista desplegable y haga clic fuera del campo. 


El Editor de niveles lee la elevación del punto sixtwo desde el proyecto y la ingresa 
en el campo Elevación ajustada. 


 


Este ciclo pasa por varios puntos en su proyecto: sixtwo, hanna y filter. Sin embargo, 
en la ejecución hay varios otros puntos que no es necesario crear. 


4. En la columna Crear, quite la selección de todos los puntos excepto para sixtwo, 
hanna y filter. 


Puesto que esta es una ejecución de nivel de ciclo, el Editor de niveles ha 
calculado una falla de cierre de 0,00550 m. 


 


Podría ajustar esta ejecución para compensar este error, tal como lo hizo con el 
archivo B412.DAT. Pero, en lugar de ello, importará los datos sin hacer un ajuste. 
Los datos se ajustarán más tarde, como parte de un ajuste de red. 


5. Haga clic en Aceptar para importar el segundo archivo de datos a su proyecto. 
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Los datos digitales de nivel recién ajustados se mostrarán en el Explorador del 
proyecto. 


 


Ha terminado de importar datos digitales de nivel a su proyecto. 


6. Seleccione Archivo > Cerrar proyecto. 


Aparecerá el diálogo Guardar cambios. Si guardó el proyecto en una nueva 
ubicación o con otro nombre, puede hacer clic en Sí. De lo contrario, haga clic en 
No. 
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Acerca de este tutorial 
En este tutorial, importará datos GNSS de control y estadísticas a un nuevo proyecto, 
combinará puntos y descargará datos de órbitas precisas y de referencia. También 
importará al proyecto una imagen georreferenciada. 


Nota:Si en cualquier momento necesita ayuda adicional mientras utiliza el software, 
presione F1 para ver la ayuda en línea. 


Paso 1. Abrir un proyecto. 
Para este tutorial, usará el archivo de proyecto Importing GNSS Data.vce. Se han 
especificado las opciones de configuración del proyecto, pero no se ha importado dato 
alguno al mismo. 


1. En la barra de menú de Trimble Business Center, seleccione Archivo > Abrir 
proyecto. O haga clic en el icono Abrir proyecto  en la barra de herramientas. 


2. En el diálogo Abrir archivo, vaya a C:\Trimble Tutorials\TBC\Projects\Importing 
GNSS Data.vce y haga clic en Abrir. 


Si instaló el tutorial en una ubicación distinta a la predeterminada que se muestra 
aquí, navegue hasta esa ubicación. 







 Paso 2. Importar datos de control GNSS  


Tutorial de Trimble Business Center – Importar datos GNSS 4 


El proyecto se abre en la ventana de Trimble Business Center. Puesto que no se 
ha importado datos al proyecto, la Vista de plano está vacía. 


 


Nota: Esta figura muestra la Vista de plano con un fondo blanco. Su fondo puede 
estar en negro. Si desea cambiarlo a blanco, seleccione Herramientas > Opciones 
y seleccione Color de fondo: Blanco en el diálogo Opciones. 


El archivo de proyecto es de sólo lectura. Puede realizar los pasos del tutorial sin 
guardar el archivo del proyecto. Sin embargo, si sufre una interrupción mientras sigue el 
tutorial, puede guardarlo al seleccionar Archivo > Guardar proyecto como y guardarlo 
en ..\Mis documentos\Trimble Business Center, que es la ubicación típica para 
guardar archivos de proyectos en su computadora. Tras ello, puede volver a abrir el 
proyecto para proseguir con el tutorial más adelante. 


Ahora está listo para importar datos de control GNSS a su proyecto. 


Paso 2. Importar datos de control GNSS 


1. Seleccione Archivo > Importar .O haga clic en el icono Importar  en la barra de 
herramientas. 


El panel Importar se abre en el lado derecho de la ventana de Trimble Business 
Center. 


2. En el panel Importar, haga clic en el botón Examinar . 
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3. En el diálogo Examinar carpeta, navegue hasta C:\Trimble 
Tutorials\TBC\Data\Importing GNSS Data y haga clic en Aceptar. 


La carpeta Importar datos GNSS contiene el archivo de Hoja de Datos NGS que se 
usará en este proyecto. Se descargó previamente del sitio web de NGS en 
http://www.ngs.noaa.gov/cgi-bin/datasheet.prl. El acceso a este sitio está disponible 
a través de la opción de menú Archivo > Descarga de Internet. 


El contenido de la carpeta Importar datos GNSS aparece en la lista Seleccionar 
archivos(s) en el panel Importar. 


 


4. En la lista Seleccionar archivo(s), seleccione B 412 ds.txt y haga clic en el botón 
Importar. 


El archivo seleccionado se importa a su proyecto y el punto calculado aparece en la 
Vista de plano. 


 



http://www.ngs.noaa.gov/cgi-bin/datasheet.prl
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5. Haga clic en el punto B 412 en la Vista de plano para seleccionarlo. Luego haga clic 
con el botón secundario y seleccione Propiedades para ver el panel Propiedades 
para el punto seleccionado. 


En el panel Propiedades, puede ver que los valores horizontales de definen como 
calidad de Control desconocido ; las alturas se fijan en calidad de Levantamiento 
(derivada de geoide) ; la elevación se fija en calidad de Control . 


 


6. Seleccione Ver > Explorador del proyecto. O haga clic en el icono Explorador del 
proyecto  en la barra de herramientas. 


Aparecerá el panel Explorador del proyecto. 


7. En el panel Explorador del proyecto, haga clic con el botón secundario en el icono 
Puntos y seleccione Expandir en el menú de contexto. Luego haga clic con el botón 
secundario en el icono Archivos importados y seleccione Expandir. 
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Ahora puede ver el archivo recién importado y el punto resultante. 


 


Ahora está listo para importar datos estáticos GNSS a su proyecto. 


Paso 3. Importar datos estáticos GNSS 


1. Seleccione Archivo > Importar .O haga clic en el icono Importar  en la barra de 
herramientas. 


El panel Importar se abre en el lado derecho de la ventana de Trimble Business 
Center. 


2. En el panel Importar, haga clic en el botón Examinar . 


3. En el diálogo Examinar carpeta, navegue hasta C:\Trimble 
Tutorials\TBC\Data\Importing GNSS Data y haga clic en Aceptar. 


El archivo de datos GPS (formato ZIP) que se encuentra en la carpeta Importar 
datos GNSS aparece en la lista Seleccionar archivos(s) en el panel Importar. 


4. Seleccione Static Data.zip en la lista Seleccionar archivos(s) y haga clic en el 
botón Importar. 


Aparecerá el diálogo Ingreso de datos brutos del receptor. 
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Puede seleccionar cualquiera de las fichas en la esquina inferior izquierda del 
diálogo para comprobar que la información esté correcta y hacer los cambios que 
sean necesarios. Por ejemplo, podría corregir una ID de punto o un código de 
característica en la ficha Punto, o cambiar la altura de la antena o el método de 
medición en la ficha Antena. 


Para ver instrucciones sobre cómo editar tipos de antena, métodos de medición y 
valores medidos, presione F1 para ver el tema de Ayuda en línea "Ingreso de datos 
GNSS brutos". En el paso 7 del tema, haga clic en el vínculo Editar múltiples 
alturas de antena. 


Para efectos de este tutorial, esta información es correcta y no es necesario hacerle 
cambios. 


5.  En el diálogo Ingreso de datos brutos del receptor, haga clic en Aceptar. 


Los datos estáticos GNSS se importan a su proyecto y se muestran en la Vista de 
plano. 


 


Para este proyecto, deberá combinar algunos puntos como se explica en el 
procedimiento siguiente. 


Paso 4. Combinar puntos 
Los puntos fsi 16406 a y fsi se han importado con variaciones de nombre ligeramente 
diferentes.  Por lo tanto, es necesario combinarlos. 


1. Seleccione Punto> Combinar puntos. 
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Aparecerá el panel  Combinar puntos. 


 


2. Puesto que fsi se ubica cerca de fsi 16406 a, haga clic en el icono Acercar   en la 
barra de herramientas para ampliar la visualización en la Vista de plano y así poder 
ver ambos puntos. O ubique el cursor en la Vista de plano y use la rueda del ratón 
para acercar la visualización. 


 


3. En el panel Combinar puntos, haga clic en el campo Datos y luego seleccione fsi y 
fsi 16406 a en la Vista de plano, trazando un cuadro alrededor de ellos. 


fsi y fsi 16406 a aparecerán en la lista Puntos seleccionados. 


4. En el área Punto final, asegúrese de que fsi  esté seleccionado en la lista 
desplegable Seleccionar punto. 


5. En la lista Puntos seleccionados, asegúrese de que estén marcadas las casillas fsi 
16406 a y fsi. 


6. Haga clic en el botón Aceptar. 


7. En el panel del Explorador del proyecto, haga clic en el símbolo + que está antes 
del icono Punto para expandir la lista de puntos. Observe que los puntos se han 
combinado. 


fsi y fsi 16406 a antes de combinarse: 
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fsi después de combinarse: 


 


Puesto que tiene puntos combinados, el indicador rojo Es necesario calcular el 
proyecto (ubicado en la parte inferior de la ventana Trimble Business Center) se 
enciende para avisarle que debe recalcular el proyecto. 


 


8. Haga en  el indicador rojo  Es necesario calcular el proyecto o presione F4 para  
recalcular el proyecto. 


Ahora está listo para descargar datos para estaciones de referencia. 


Paso 5. Descargar datos de estación de referencia 
En este procedimiento, usará el comando Descargar de Internet para descargar datos 
de estación de referencia desde un sitio CORS local. 


1. Seleccione Proyecto > Descarga de Internet. En el panel Descarga de Internet, 
haga clic en  en la barra de herramientas. 


Aparecerá el panel Descargar de Internet. 


 


2. Haga clic en el icono Configuración de descargas de Internet   cerca de la 
parte superior del panel. 


3. En el diálogo Configuración de descargas de Internet, haga clic en el botón 
Nuevo sitio. 
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Aparecerá el diálogo Nuevo sitio.  Para este proyecto, seleccionará de una lista de 
proveedores disponible en el sitio web de Trimble. 


4. Seleccione la opción Seleccionar de una lista predefinida y asegúrese de que esté 
marcada la casilla que hay bajo ella. Luego, haga clic en Aceptar. 


Aparece el diálogo Añadir proveedor predefinido de estación de referencia, 
mostrando la lista actual de proveedores de datos de estaciones de referencia que 
encuentra en el sitio web de Trimble. Los proveedores aparecen en orden 
secuencial, comenzando por el que está más cercano a la ubicación central del 
proyecto. 


Observe que puede hacer clic en cualquier cabecera de columna para ordenar las 
files según la columna. 


 


5. En el diálogo Añadir proveedor predefinido de estación de referencia, seleccione 
CORS, MARSHALL FIELD p041 en la lista. Luego, haga clic en Aceptar. 


Las propiedades de sitio para esta estación de referencia aparecen en el diálogo 
Propiedades de nuevo sitio para Estaciones de referencia de grupo. No es 
necesario hacer ningún cambio. 


6. Haga clic en  Aceptar. 


El proveedor seleccionado aparecerá en el diálogo Configuración de descargas de 
Internet. 


 


7. Haga clic en  Aceptar. 







 Paso 5. Descargar datos de estación de referencia  


Tutorial de Trimble Business Center – Importar datos GNSS 12 


El proveedor seleccionado aparecerá en el panel  Descargar de Internet. 


 


8. Haga doble clic en P041 – CORS, MARSHALL FIELD o seleccione la estación y 
haga clic en el botón Automático en la parte inferior del panel. 


Aparecerá el diálogo Parámetros de descarga. Si el proyecto incluía múltiples 
periodos de tiempo, puede seleccionarlos en la lista desplegable. Pero, como este 
proyecto tiene solamente un periodo de tiempo, no necesita hacer una selección. 


9. Haga clic en  Aceptar. 


Aparece una nueva ficha #1 en el panel Descargar de Internet, mostrando los 
archivos que se están descargando y los archivos listos para importación. La acción 
asociada con cada archivo está predeterminada y se muestra en la columna Acción. 
Puede cambiar cualquier acción, seleccionándola. 


 


Nota Los archivos de registro y del texto readme (.txt) no se pueden importar, pero 
se pueden guardar con los datos del proyecto. Para hacerlo, debe cambiar la acción 
de Eliminar a Guardar. 


10. Haga clic en el botón Importar en la ficha #1 para importar el marco cronológico. 


Aparecerá el diálogo Ingreso de datos brutos del receptor. Por lo general, tendría 
que comprobar los datos en todas las fichas para asegurarse de que estén 
correctos. Para este tutorial, todo está correcto, por lo que no hay necesidad de 
realizar esta comprobación. 


11. Haga clic en  Aceptar. 
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Los datos de estación  de referencia recién importados se representan en el panel 
Explorador del proyecto y en la Vista de plano. 


 


Ahora está listo para descargar datos de órbita precisa a su proyecto, de manera que 
pueda procesar líneas base. 


Paso 6. Descargar datos de órbita precisa 
Para procesar líneas base en su proyecto, puede descargar e importar órbitas precisas 
para el marco cronológico de los datos GNSS. Puesto que los datos de este proyecto se 
recolectaron en el pasado, puede usar los datos de órbita precisa cuando procese las 
líneas base.  


1. En el panel Descargar de Internet, haga doble clic en Órbitas finales IGS. 
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Aparecerá el diálogo Parámetros de descarga. 


 


Si el proyecto incluía múltiples periodos de tiempo, puede seleccionarlos en la lista 
desplegable. Pero, como este proyecto tiene solamente un periodo de tiempo, no 
necesita hacer una selección. 


2. Haga clic en  Aceptar. 


Los archivos se muestran para descarga en la ficha #2 . 


 


3. Repita este procedimiento para  Órbitas Glonass finales IGS en la ficha Inicio del 
panel Descargar de Internet. 


4. En el panel Descargar de Internet, haga clic en el botón Importar en las fichas #2 y 
#3 para importar cada marco cronológico. 


A continuación, importará una imagen que incluya datos de georreferencia integrados al 
archivo de imagen mismo. La imagen aparecerá en la Vista de plano en base a las 
coordenadas globales especificadas en los datos georreferenciados. 


Nota: También puede importar un archivo de imagen que no incluya datos de 
georreferencia integrados, sino que en lugar de ello incluye un archivo de datos de 
georreferencia mundial asociado. El archivo asociado debe tener el mismo nombre de 
archivo que la imagen georreferenciada, pero con una extensión de archivo distinta (por 
ejemplo, .wld o .ini). 
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Paso 7. Importar una imagen georreferenciada 


1. Seleccione Archivo > Importar .O haga clic en el icono Importar  en la barra de 
herramientas. 


El panel Importar se abre en el lado derecho de la ventana de Trimble Business 
Center. 


2. En el panel Importar, haga clic en el botón Examinar . 


3. En el diálogo Examinar carpeta, navegue hasta C:\Trimble 
Tutorials\TBC\Data\Importing GNSS Data y haga clic en Aceptar. 


El contenido de la carpeta Importar datos GNSS aparece en la lista Seleccionar 
archivos(s) en el panel Importar. 


4. En la lista Seleccionar archivo(s), seleccione Westmoore2.tif y haga clic en el botón 
Importar. 


Haga clic en No en el mensaje de diálogo Importar errores. La imagen fotográfica 
aparecerá en la Vista de plano. 


 


Si la imagen no se ve correctamente (por ejemplo, aparece como un cuadro negro), 
es posible que deba cambiar la resolución de pantalla a fin de reducir la cantidad de 
memoria necesaria para su visualización. Si cambia a una menor resolución de 
pantalla, bajará la calidad de la imagen, pero no cambiará su tamaño en la Vista de 
plano. En muchos casos, ni siquiera advertirá el cambio de calidad. 
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Puesto que Westmoore2.tif es una imagen de muy alta resolución, puede cambiar a 
una resolución más baja sin perder calidad apreciable. Seleccione Herramientas > 
Opciones. En el diálogo Opciones, haga clic en el botón Avanzadas. En el diálogo 
Opciones gráficas avanzadas, seleccione la opción Reducción para muestra 
(Down-sampled) y seleccione 512x512. Luego, haga clic en Aceptar y en Aceptar. 


5. Use la rueda del ratón para acercar la imagen, como se muestra aquí. 


Observe que puede seleccionar puntos y líneas base, las que lo se superponen a la 
imagen. 


 


De manera predeterminada, no se pueden seleccionar la imagen misma en la Vista 
de plano. 


6. Para hacer seleccionable la imagen en la Vista de plano: 


a. Seleccione Ver > Administrador de filtros de vista. 


b. En el panel Administrador de filtros de vista, haga clic en el icono 
Configuración avanzada de filtros de vista . 
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c. En el diálogo Configuración avanzada de filtros de vista, marque la casilla de 
verificación Seleccionable para la Imagen georreferenciada. Luego, haga clic 
en Aceptar. 


 


7. Para ver propiedades de la imagen georreferenciada, haga clic en la esquina 
superior derecha de la imagen en la Vista de plano a fin de seleccionarla. Luego, 
haga clic con el botón secundario y seleccione Propiedades en el menú de 
contexto. 


En el panel Propiedades hay dos configuraciones que se pueden modificar: 


 La opción Prioridad de visualización permite mover la imagen hacia delante o 
atrás en relación con otras imágenes, ingresando un valor de Prioridad de 
visualización entre 1 y 5 (1 es el valor que hace la imagen más visible y 5 es el 
valor que la hace más oculta). 


También puede hacer clic con el botón secundario en la imagen en la Vista de 
plano y seleccionar una opción de menú para hacerla mover hacia primer o 
segundo plano. 


 La opción Visible le permite determinar que la imagen se vea o no en la Vista 
de plano. 


Ha terminado de importar datos GNSS a su proyecto. 


8. Seleccione Archivo > Cerrar proyecto. 


Aparecerá el diálogo Guardar cambios. Si guardó el proyecto en una nueva 
ubicación o con otro nombre, puede hacer clic en Sí. De lo contrario, haga clic en 
No. 


Ahora que ha importado datos GNSS a su proyecto, está listo para procesar líneas base 
GNSS. Consulte el tutorial Procesar líneas base GNSS para ver instrucciones. 
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Acerca de este tutorial 
En este tutorial, importará datos de estación total a un proyecto que ya contiene datos 
GNSS y datos de nivel. Luego, eliminará una configuración incorrecta, cambiará el tipo 
de prisma para una observación y verá los residuales de ángulo medio. 


Nota: Si en cualquier momento necesita ayuda adicional mientras utiliza el software, 
presione F1 para ver la ayuda en línea. 


Paso 1. Abrir un proyecto. 
Para este tutorial, usará el archivo de proyecto Importing Total Station Data.vce. Los 
datos GNSS y los datos digitales de nivel ya fueron importados al proyecto, y las líneas 
base GNSS fueron procesadas. 


1. En la barra de menú de Trimble Business Center, seleccione Archivo > Abrir 
proyecto. O haga clic en el icono Abrir proyecto  en la barra de herramientas. 


2. En el diálogo Abrir archivo, vaya a C:\Trimble Tutorials\TBC\Projects\Importing 
Total Station Data.vce y haga clic en Abrir. 


Si instaló el tutorial en una ubicación distinta a la predeterminada que se muestra 
aquí, navegue hasta esa ubicación. 
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El proyecto se abre en la ventana de Trimble Business Center. 


 


Nota: Esta figura muestra la Vista de plano con un fondo blanco. Su fondo puede 
estar en negro. Si desea cambiarlo a blanco, seleccione Herramientas > Opciones 
y seleccione Color de fondo: Blanco en el diálogo Opciones. 


El archivo de proyecto es de sólo lectura. Puede realizar los pasos del tutorial sin 
guardar el archivo del proyecto. Sin embargo, si sufre una interrupción mientras sigue el 
tutorial, puede guardarlo al seleccionar Archivo > Guardar proyecto como y guardarlo 
en ..\Mis documentos\Trimble Business Center, que es la ubicación típica para 
guardar archivos de proyectos en su computadora. Tras ello, puede volver a abrir el 
proyecto para proseguir con el tutorial más adelante. 


Ahora está listo para importar datos de estación total a su proyecto. 


Paso 2. Importar datos de estación total 
Para este tutorial, importará un archivo de datos que contiene datos de poligonal 
capturados con una estación total. Sin embargo, debido a la precisión del equipo que se 
usa para capturar datos para este levantamiento, usted aumentará la tolerancia 
predeterminada especificada para ángulos medios en su proyecto antes de importar los 
datos. 


1. Para aumentar la tolerancia predeterminada especificada para ángulos medios, 
realice lo siguiente: 


a. Seleccione Proyecto > Configuraciones del proyecto. 
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b. En el diálogo Configuración del proyecto, seleccione Cálculos > Ángulos 
medios en la lista de navegación. 


c. En la sección Tolerancia de ángulos medios, ingrese 0°00'05" en los campos 
Ángulo horizontal y Ángulo vertical. 


 


Ahora está listo para importar datos. 


2. Seleccione Archivo > Importar .O haga clic en el icono Importar  en la barra de 
herramientas. 


El panel Importar se abre en el lado derecho de la ventana de Trimble Business 
Center. 


3. En el panel Importar, haga clic en el botón Examinar . 


4. En el diálogo Examinar carpeta, navegue hasta C:\Trimble 
Tutorials\TBC\Data\Importing Total Station Data y haga clic en Aceptar. 


La carpeta Importar datos de estación total contiene el archivo de datos JXL que se 
usará en este proyecto. 


El contenido de la carpeta Importar datos de estación total aparece en la lista 
Seleccionar archivos(s) en el panel Importar. 


 


5. En la lista Seleccionar archivo(s), seleccione filloop.jxl y haga clic en el botón 
Importar. 


Debido a que el software detecta una diferencia entre el sistema de coordenadas 
especificado en el proyecto y el sistema de coordenadas especificado en el archivo 
importado, aparece el diálogo de mensaje Sistema de coordenadas del proyecto. 


6. En el diálogo de mensaje Sistema de coordenadas del proyecto, haga clic en el 
botón Detalles. 
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El Informe comparativo de sistema de coordenadas aparece en una ventana de 
navegador donde los valores del proyecto y los valores importados se ven uno al 
lado del otro. Las diferencias aparecen resaltadas. Para este tutorial, usará los 
valores del proyecto. 


7. Cierre el informe y seleccione la opción Mantener la actual definición del proyecto 
en el diálogo de mensaje Sistema de coordenadas del proyecto. Luego, haga clic 
en Aceptar. 


Aparece un diálogo de mensaje Errores al importar,que indica que hay una 
advertencia asociada con la importación y pregunta si desea revisar el Resumen de 
importación.  


8. En el diálogo Importar errores, haga clic en Sí 


El Resumen de importación se abre en la ventana de su navegador. 


9. Desplácese al final del informe donde aparece la advertencia. 


La advertencia indica que la configuración de una estación  está incompleta. Para 
este levantamiento, los topógrafos del campo empezaron equivocadamente al usar 
Configuración de estación plus para el tipo de configuración, que está representado 
por el filtro (S1). En su lugar, debieron haber empezado con un tipo de configuración 
Referencia única y rondas, que está representado por el filtro (S2). Para solucionar 
este problema, debe eliminar la primera configuración. 


10. Para eliminar la configuración, realice lo siguiente: 


a. Haga clic en el vínculo de advertencia en el informe Resumen de importación 
para seleccionar la configuración de la estación. 


b. En la ventana Trimble Business Center, haga clic con el botón secundario en 
la Vista de plano y seleccione Explorador de selecciones.  


Nota: Si hace clic en cualquier otro lugar de la ventana antes de hacer clic con el 
botón secundario en la Vista de plano, la configuración de la estación ya no estará 
seleccionada. Además, si vuelve a seleccionar la advertencia en el informe, el 
número de configuración será distinto a lo que se muestra más abajo. 
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Aparecerá el panel Explorador de selecciones. La configuración que va a 
eliminar está seleccionada en la lista Instantánea de selección. 


 


c. Haga clic con el botón secundario en el filtro (S1) en la lista Instantánea de 
selección y seleccione Eliminar. 


11. Seleccione Proyecto > Calcular proyecto, o presione F4  para recalcular el 
proyecto. 


12. Haga clic en el icono Acercar  en la barra de herramientas para ampliar la 
visualización en la Vista de plano como se ve aquí. Si lo prefiere, haga clic en la 
Vista de plano y use la rueda del ratón para acercarse. Presione la rueda del ratón y 
muévalo para centrar los puntos. 
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Con la ampliación de la vista, puede ver mucho más fácilmente los datos recién 
importados. 


13. Seleccione Ver > Explorador del proyecto. O haga clic en el icono Explorador del 
proyecto  en la barra de herramientas. 


14. En el panel Explorador del proyecto, haga clic en el símbolo más que está antes 
del icono Archivos importados. Luego, haga clic en el signo que aparece antes del 
archivo filloop.jxl recién importado para ver los datos. 


El nodo Redes de poligonales indica que el topógrafo realizó un ajuste de 
poligonales en Survey Controller. 


 


 


Paso 3. Ver propiedades para un ajuste de poligonal 
1. En el panel Explorador del proyecto, haga clic con el botón secundario en Redes 


de poligonales > recorrido de campo (filloop.jxl) y seleccione Propiedades. 
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El panel Propiedades muestra los valores de falla de cierre y precisión preajustados 
y ajustados, junto con los métodos de distribución de errores, los puntos de 
inicio/final/intermedios y el tipo de ajuste. También muestra si este ajuste es el más 
reciente efectuado a estas coordenadas de puntos. 


 


Debido a que un ajuste se puede realizar varias veces con el software Trimble 
Access/Survey Controller, se usa solamente un ajuste en la solución de estos 
puntos. En un archivo de trabajo puede haber varios poligonales que ajustan otros 
puntos. 


Los puntos que se regulan mediante un ajuste de poligonal se encuentran en un 
estado "fijo". No se volverán a calcular mediante un cambio en las coordenadas de 
los puntos de  inicio y final a menos que usted realice un ajuste de red de mínimos 
cuadrados (seleccione Levantamiento > Ajustar red). 


Para ver este estado, debe observar en el Informe de derivación de puntos el punto 
w. Este punto resulta interesante porque usted sabe que los topógrafos en el campo 
ingresaron el tipo de prisma incorrecto para las observaciones usadas para 
determinar este punto. 


2. Para ver el Informe de derivación de puntos, realice lo siguiente: 


a. Haga clic en el icono Acercar  en la barra de herramientas o usar la rueda del 
ratón para acercarse al punto w en la Vista de plano. 


b. Haga clic en el punto w y seleccione Punto w en la lista. 


c. Haga clic con el botón secundario en la Vista de plano y seleccione Informe de 
derivación de puntos en la lista. 
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El informe se muestra en una ventana del navegador. Puede ver que los 
indicadores Usados para calc.  se encuentran en la línea Poligonal ajustado 
del informe. También puede ver las importantes diferencias entre el punto y el 
ángulo medio w-x-w (M11). Este es el ángulo medio para el cual el tipo de 
prisma se ingresó incorrectamente en el campo. Corregirá este error en el 
próximo paso. 


 


 


Paso 4. Corrija el error del tipo de prisma cometido en 
el campo. 


Debido a que los topógrafos en el campo ingresaron el tipo de prisma incorrecto para las 
observaciones dentro del ángulo medio w-x-w (M11), debe corregir el error antes de 
continuar. Este error también se incluyó en el ajuste de poligonal realizado en el software 
de campo. Debido a que la corrección de este error invalidará los resultados del ajuste 
de poligonal, usted borrará los resultados del ajuste de poligonal antes de corregir el tipo 
de prisma. 


Nota: Aunque el software no admite la ejecución de un ajuste de poligonal dentro del 
proyecto (solamente puede importar los resultados de ajuste de poligonal de Survey 
Controller o Trimble Access), sí admite un ajuste de red de mínimos cuadrados (consulte 
el tutorial Ajustar la red). Si este era un trabajo independiente y usted estaba basando 
el proyecto en las coordenadas de poligonal ajustadas, debe corregir el tipo de prisma y 
volver a ajustar el poligonal en el campo software. A continuación, puede volver a 
importar el archivo a su proyecto. 


1. En el panel Explorador del proyecto, haga clic con el botón secundario en Redes 
de poligonales > recorrido de campo (filloop.jxl) y seleccione Borrar los resultados 
del ajuste de poligonal. 
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Ahora se muestra un indicador de error en el punto w en la Vista de plano que 
indica que el punto excede las tolerancias especificadas para los puntos del 
proyecto. 


 


2. Seleccione el punto w en la Vista de plano y seleccione el Punto: w en la lista. 
Luego, haga clic con el botón secundario y seleccione Informe de derivación de 
puntos. 


Los valores ajustados de poligonal ya no aparecen en el informe. El ángulo medio w-
x-w (M11) aparece con texto en rojo que indica que el punto excede las tolerancias 
que usted especificó para los ángulos medios vistos anteriormente en el tutorial. Al 
borrar los resultados de ajuste de poligonal, ahora puede corregir el tipo de prisma 
incorrecto. 


3. En el Explorador del proyecto, expanda Archivos importados > filloop.jxl > x (S7) 
> Rondas > Conjunto 1. Luego haga clic con el botón secundario en  x-w (T161) y 
seleccione Propiedades en el menú de contexto. 


Las propiedades de la observación se mostrarán en el panel  Propiedades. 


 


Tenga en cuenta que pudo haber guardado cualquiera de las observaciones dentro 
del ángulo medio w-x-w (M11) dado que se le pedirá que las cambie todas. 
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4. En el panel Propiedades, seleccione Grande 63,5mm inclinable en la lista 
desplegable Tipo de prisma, en la sección Información de destino. 


5. Cuando aparece el mensaje que le pregunta si desea extender el cambio de prisma 
a todas las demás observaciones dentro de este ángulo medio, haga clic en Sí. 


El cambio de prisma se realiza a todas las observaciones dentro del ángulo medio. 
Ahora debe recalcular el proyecto. 


6. Seleccione Proyecto > Calcular proyecto, o presione F4  para recalcular el 
proyecto. 


Ya no aparece el indicador para el punto w en la Vista de plano. 


7. Abra otro Informe de derivación de puntos para el punto w y revise los cambios. 


Ahora está listo para ver los residuales para un ángulo medio en el proyecto. 


Paso 5. Ver residuales de ángulo medio 
Un ángulo medio representa la combinación y promediación de observaciones 
redundantes al mismo punto. Puede ver residuales para cualquier ángulo medio y, si lo 
desea, deshabilitar las observaciones discordantes que puedan existir.  


Para este tutorial, revisará los residuales para el ángulo medio w-x-y (M12). Este ángulo 
medio se indica en la Vista de plano porque hay observaciones en él que exceden las 
tolerancias que configuró para los ángulos medios vistos anteriormente en este tutorial. 


1. En el Explorador del proyecto, expanda filloop.jxl > x (S7) > Rondas. Luego, haga 
clic con el botón secundario w-x-y (M12) y seleccione Residuales de ángulo medio 
en el menú de contexto. 


Aparecerá el diálogo Residuales de ángulo medio. 
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Aparecen indicadores para las cuatro observaciones dentro del ángulo medio. Usted 
deshabilitará las observaciones con los mayores residuales en primer lugar, para ver 
si esto corrige las otras observaciones indicadas. 


2. Borre la casilla de verificación para la observación x-y (T170). 


Observe que, a medida que habilita o deshabilita observaciones, las medias y los 
residuales se recalculan, de manera que pueda ver de inmediato los efectos del 
cambio. Sin embargo, estos cambios son temporales y no se aplican al proyecto sino 
hasta que usted hace clic en Aceptar. 


Puede hacer clic en el botón Informe para ver el Informe de ángulo medio, el cual 
proporciona información adicional acerca de cada observación. 


3. En el diálogo Cambiar estado de observación, haga clic en Sí para aplicar el 
mismo cambio a x-y (T172). 


Tenga en cuenta que aún se muestran los indicadores para x-y (T166) y x-y (T168), 
así que deberá deshabilitarlos también. 


4. Borre la casilla de verificación para la observación x-y (T168). 


5. En el diálogo Cambiar estado de observación, haga clic en Sí para aplicar el 
mismo cambio a x-y (T166). 


6. Haga clic en  Aceptar. 


7. Seleccione Proyecto > Calcular proyecto, o presione F4  para recalcular el 
proyecto. 


El ángulo medio w-x-y (M12) ya no está indicado en la Vista de plano. 


 


Terminó de importar datos de estación total a su proyecto. 


8. Seleccione Archivo > Cerrar proyecto. 


Aparecerá el diálogo Guardar cambios. Si guardó el proyecto en una nueva 
ubicación o con otro nombre, puede hacer clic en Sí. De lo contrario, haga clic en 
No. 
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Acerca de este tutorial 
En este  tutorial, procesará datos GNSS que ya se han importado al proyecto. 


Notas: 


 Para este tutorial, procesará líneas base para datos que incluyen señales L1 y L2. 
Puede realizar los procedimientos que se describen en el tutorial al ejecutar Trimble 
Business Center con la licencia de producto Survey Standard; sólo se procesarán 
los datos L1. La licencia de producto Survey Advanced se requiere para procesar 
líneas base L1 y L2. Para comprobar la licencia de producto para su instalación, 
seleccione Ayuda > Acerca de Trimble Business Center y haga clic en el botón 
Licencia. Las funciones con licencia se muestran en la lista Funciones. 


  Si en cualquier momento necesita ayuda adicional mientras utiliza el software, 
presione F1 para ver la ayuda en línea. 


 


Paso 1. Abrir un proyecto. 
Para este tutorial, usará el archivo de proyecto Processing GNSS Baselines.vce. Los 
datos GNSS ya se han importado al proyecto, pero las líneas base no se han procesado 
todavía. 


1. En la barra de menú de Trimble Business Center, seleccione Archivo > Abrir 
proyecto. O haga clic en el icono Abrir proyecto  en la barra de herramientas. 


2. En el diálogo Abrir archivo, vaya a C:\Trimble Tutorials\TBC\Projects\Processing 
GNSS Baselines.vce y haga clic en Abrir. 


Si instaló el tutorial en una ubicación distinta a la predeterminada que se muestra 
aquí, navegue hasta esa ubicación. 







 Paso 1. Abrir un proyecto.  


Tutorial de Trimble Business Center – Procesar líneas base GNSS 4 


El proyecto se abre en la ventana de Trimble Business Center. 


 


Nota: Esta figura muestra la Vista de plano con un fondo blanco. Su fondo puede 
estar en negro. Si desea cambiarlo a blanco, seleccione Herramientas > Opciones 
y seleccione Color de fondo: Blanco en el diálogo Opciones. 


El archivo de proyecto es de sólo lectura. Puede realizar los pasos del tutorial sin 
guardar el archivo del proyecto. Sin embargo, si sufre una interrupción mientras sigue el 
tutorial, puede guardarlo al seleccionar Archivo > Guardar proyecto como y guardarlo 
en ..\Mis documentos\Trimble Business Center, que es la ubicación típica para 
guardar archivos de proyectos en su computadora. Tras ello, puede volver a abrir el 
proyecto para proseguir con el tutorial más adelante. 


Antes de procesar las líneas base para el proyecto, debe verificar la configuración del 
procesamiento de líneas base para asegurarse de que sean adecuadas para su 
proyecto. 
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Paso 2. Especifique el intervalo de procesamiento 
Antes de procesar las líneas base para el proyecto, puede elegir el intervalo (en 
segundos) según el cual desea seleccionar datos de campo para procesar, o bien puede 
usar el intervalo especificado en el archivo de datos. Mientras más corto sea el intervalo, 
más datos se procesarán, lo que deriva en una extensión del tiempo de procesamiento y 
una mayor precisión. Si escoge un intervalo más corto que el intervalo al que se 
reunieron los datos, se utilizará este último.  


Idealmente, debe elegir el intervalo especificado en el archivo de datos para asegurarse 
de usar los intervalos más cortos posibles. Sin embargo, para tiempos de ocupación 
prolongados con intervalos (generaciones) de 1 segundo o menos, el tiempo de 
procesamiento podría ser muy largo. En este caso, debería elegir un intervalo más 
prolongado para reducir el tiempo de procesamiento. Para este tutorial, usted 
seleccionará un intervalo de procesamiento de 5 segundos para mantener el tiempo de 
procesamiento lo más breve posible.  


1. Seleccione Proyecto > Configuraciones del proyecto. O haga clic en el icono 
Configuraciones del proyecto  en la barra de herramientas. 


2. En el panel de navegación (izquierdo) en el diálogo Configuraciones del proyecto, 
seleccione Procesamiento de líneas base > Procesamiento. 


3. En la lista desplegable Intervalo de procesamiento, seleccione 5 (segundos). 


 


Tenga en cuenta que puede seleccionar otras opciones que afecten al 
procesamiento de líneas base. En la parte inferior del diálogo aparecen consejos 
útiles, o puede presionar  F1 en cualquier momento para ver ayuda adicional en 
línea. Para este tutorial, no debe hacer ningún otro cambio. 


4. Haga clic en Aceptar para cerrar el diálogo Configuración del proyecto. 


Ahora está listo para procesar sus líneas base. 


Paso 3. Procesar líneas base 
1. Seleccione Levantamiento > Procesar líneas base. O bien haga clic en el icono 


Procesar líneas base  en la barra de herramientas. 
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Nota: Si no se selecciona ninguna línea base en las distintas vistas cuando 
selecciona el comando Procesar líneas base (como en este caso), se procesan 
todas las líneas base de su proyecto. Si se selecciona cualquier línea base, 
solamente esas líneas base se procesan. 


Aparece el diálogo Procesar líneas base y muestra el avance del proceso. 


 


Cuando el procesamiento termina, las líneas base procesadas aparecen en la tabla. 
Puede ordenar las líneas base según sea necesario, al hacer clic en cualquiera de 
los encabezados de las columnas. Por ejemplo, puede ordenar las líneas base para 
verificar si se cumplió con la precisión deseada al hacer clic en los encabezados de 
las columnas Precisión Horiz. y Precisión  vert.  


Para ver más información sobre cualquier línea base específica, seleccione la fila y 
haga clic en el botón Informe para ver el Informe de procesamiento de líneas 
base en formato HTML en la ventana de su navegador. 


Nota: Cuando selecciona un Informe de procesamiento de líneas base abierto desde 
cualquier otra parte en Trimble Business Center, el informe abre una ficha de 
visualización en formato RDLC (Report Definition Language Client), que después se 
puede guardar en formato PDF. 


2. En el diálogo Procesar líneas base, haga clic en el botón Guardar para guardar las 
líneas base procesadas. 


El proyecto se recalcula con las líneas base recién creadas. 


Puede ver el Informe de derivación de puntos de cualquier punto para revisar las 
coordenadas resultantes.  


3. Seleccione el punto fsi en la Vista de plano. Haga clic con el botón secundario y 
seleccione Informe de derivación de puntos en el menú de contexto. 


El Informe de derivación de puntos aparecerá en una ventana de navegador. 
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Si aparece un indicador de error para una línea base en el diálogo Procesar líneas 
base, debe asegurarse de que toda la información sobre esa línea base sea correcta 
(por ejemplo, el tipo de antena, la altura de la antena y el nombre del punto). En algunos 
casos, el reprocesamiento de la línea base por sí misma borrará un indicador al usar una 
inicialización de coordenadas diferente. Dependiendo del problema subyacente, hay 
diversas acciones que puede realizar, entre ellas la posible edición de la sesión 
asociada. 


En el próximo paso, editará una sesión y reprocesará una línea base como si se hubiera 
mostrado un indicador de error en el diálogo Procesar líneas base, aunque no haya 
sido así. Esto le ayudará a familiarizarse con el Editor de sesiones. 


Paso 4. Edite una sesión y reprocese una línea base 
El Editor de sesiones le permite analizar visualmente la calidad de los datos satelitales 
brutos de la sesión seleccionada. Las brechas en los datos satelitales pueden ser indicio 
de pérdida de ciclo de la señal del satélite, errores de gama no válida y otros problemas 
de pérdida de señal. Para mejorar la calidad de una línea base procesada, puede usar el 
Editor de sesiones para deshabilitar satélites en mal estado, enmascarar secciones 
defectuosas de datos satelitales y ajustar tiempos de ocupación. 


En este paso, editará una sesión asociada con una línea base para corregir brechas en 
la señal satelital. Luego, reprocesará la línea base.  


Nota: Este procedimiento está diseñado para que se familiarice con el Editor de 
sesiones. Si este fuera un proyecto real, no habría necesidad de reprocesar la línea 
base especificada, puesto que está dentro de los criterios de aceptación especificados 
para el proyecto. 


1. Haga clic en la Vista de plano y con la rueda del ratón haga un acercamiento para 
distinguir la línea base entre los puntos fsi y 3. A continuación, haga clic en la línea 
base y seleccione fsi de línea base --- 3 (B15) en el menú de contexto. 


 


2. Haga clic con el botón secundario en cualquier parte en la Vista de plano y 
seleccione Editor de sesiones en el menú de contexto. 
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Aparecerá el diálogo Editor de sesiones. 


 
Los satélites que proporcionan datos para la sesión incluyen líneas de color azul y/o 
verde en la línea de tiempo. Cada línea azul representa datos capturados para el 
primer punto en la línea base (fsi). Cada línea verde representa datos capturados 
para el segundo punto en la línea base (3). 


Cada satélite está representado por una letra y un número en la columna izquierda: 


 G = Satélite GPS 


 R = Satélite GLONASS 


 E = Satélite Galileo  


Tenga en cuenta que la señal para el G7 de satélite termina anticipadamente en la 
sesión. Probablemente el satélite se movió más allá del horizonte en ese punto. 
Aunque no es necesario en este caso, deshabilitará  los datos G7 del satélite para 
este tutorial. 


3. En la columna izquierda, haga clic en G7. 


Toda la fila está sombreada para mostrar que los datos satelitales se deshabilitarán 
(es decir, los datos no se usarán para procesamiento) cuando haga clic en Aceptar. 


A continuación, deshabilitará parte de los datos de los satélites R17 y R18 en los 
cuales hay pérdidas de ciclo como lo indican las separaciones en las líneas azul y 
verde. 


4. En la fila R17, haga clic en frente de la primera pérdida y arrastre el cursor al final de 
la fila. 
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5. En la fila R18, haga clic y arrastre a través de las pérdidas de ciclo en la parte inicial 
de la sesión. 


 


En este procedimiento, usted deshabilita datos satelitales solamente para la línea 
base seleccionada. Si desea deshabilitar un satélite para todas las líneas base de su 
proyecto, seleccione Proyecto > Configuraciones del proyecto. Luego, seleccione 
Procesamiento de líneas base > Satélites y borre la marca de verificación del 
satélite que desea deshabilitar. Aquí es también donde usted pude subir o bajar la 
máscara de elevación para probar y mejorar los resultados de las líneas base. 


6. Haga clic en Aceptar para cerrar el diálogo Editor de sesiones. 


Ahora está listo para procesar la línea base. 


7. Con fsi de línea base--- 3 (B15) todavía seleccionado, seleccione  Levantamiento > 
Procesar líneas base. O bien haga clic en el icono Procesar líneas base  en la 
barra de herramientas. 


Aparece el diálogo Procesar líneas base y se reprocesa la línea base seleccionada. 


8. Cuando el procesamiento esté listo, haga clic en el botón Guardar. 


Terminó de procesar las líneas base GNSS. En el próximo paso, usted identificará y 
deshabilitará las líneas base dependientes de su proyecto. 


Paso 5. Identificar y deshabilitar las líneas base 
dependientes 


Si piensa utilizar solamente líneas base independientes en el ajuste de red, puede usar 
la Vista cronológica para identificar las líneas base dependientes y deshabilitarlas. 


Nota: Al deshabilitar una línea base se elimina el vector asociado. Si desea conservar un 
vector debe deshabilitarlo, no la línea base. Las instrucciones para deshabilitar vectores 
no se incluyen en este tutorial. 


A continuación se encuentra un diagrama de los datos de levantamiento usados en este 
proyecto. 
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Los números dentro de un círculo indican la sesión en la que se midió cada línea base. 
En la sesión 1, se ocuparon puntos fsi, 5, frey y hanna. El número total de líneas base 
que se pueden observar durante una sesión es igual a  


 
donde n corresponde al número de receptores usados durante la sesión. 


Por ejemplo, si se usaron cuatro receptores en una sesión, se pueden observar seis 
líneas base (4 veces 3, dividido por 2). 


El número de líneas base independientes para una sesión determinada es igual a . 


Para este proyecto, se midieron tres líneas base independientes para cada sesión. En 
las cinco sesiones observadas, se midieron 30 líneas base, pero solamente 15 son 
independientes.  


El uso de la estación CORS, debe agregar otro receptor al recuento. Esto aumenta el 
total de líneas base por sesión a 10 y el número de líneas base independientes a 4. Hay 
un total de 50 líneas base y 20 líneas base independientes para todas las sesiones. 


Para deshabilitar las líneas base dependientes, siga estos pasos: 


1. Seleccione Vista> Nueva vista cronológica. O bien haga clic en el icono Nueva 
vista cronológica  en la barra de herramientas. 
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Aparecerá la Vista cronológica. La siguiente figura identifica las sesiones 1 y 2. 
(Las demás sesiones no aparecen en esta figura.) 


 


Puede usar el ratón para navegar por la Vista cronológica de la siguiente forma: 


 Coloque el cursor sobre las sesiones, presione la rueda del ratón y mueva el 
ratón hacia atrás y adelante para acercar la vista horizontalmente. 


 Use la rueda del ratón para desplazar la vista verticalmente hacia arriba y abajo. 


 Coloque el cursor sobre las sesiones, mantenga presionado el botón izquierdo 
del ratón y mueva el ratón hacia arriba para acercar la vista o muévalo hacia 
abajo para alejarla. 


 Haga clic con el botón secundario para ver otras opciones de zoom. 
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2. Para asegurarse de que trabaja con la sesión correcta, use Mayús + clic en la 
columna izquierda para seleccionar todas las líneas base en la sesión 1. 


 


3. Al usar Ctrl + clic, se cancela la selección de las líneas base independientes de la 
sesión 1. Estas son las líneas base que no debe deshabilitar. 


 P041 --- hanna  
Tenga en cuenta que debido a que usted usa la observación desde P041 a los 
puntos en el exterior de su red, debe quitar la selección de esta línea base. 


 5 --- fsi  


 hanna --- frey  
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 5 --- frey  


 


4. Haga clic con el botón secundario en cualquiera de las restantes líneas base 
seleccionadas en la sesión 1 y seleccione Deshabilitar líneas base en el menú de 
contexto. 


Aparece un mensaje que le alerta que los vectores asociados se eliminarán.  


5. En el diálogo de mensaje Eliminar vectores, haga clic en Sí. 


6. En la Vista cronológica, las líneas base deshabilitadas aparecen con una barra 
color gris oscuro. 
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7. Repita este procedimiento con las sesiones 2 a 5, asegurándose de que todas las 
líneas base dependientes estén deshabilitadas. 


Las líneas base independientes para cada sesión son las siguientes. Estas líneas 
base no se deben seleccionar para deshabilitarlas. Las demás líneas se deben 
seleccionar para deshabilitarlas. 


Sesión 2: 


 3 --- filtro  


 P041 --- sixtwo  


 3 --- sixtwo  


 sixtwo --- hanna  


Sesión 3: 


 hanna --- filtro 


 filtro --- 5 


 filtro --- frey  


 P041 --- frey  


Sesión 4: 


 P041 --- fsi  


 fsi --- 3  


 3 --- sixtwo  


 3 --- 5  


Sesión 5: 


 P041 --- sixtwo  


 frey --- hanna  


 frey --- 5  


 sixtwo --- hanna  


Ahora que deshabilitó las líneas base, debe recalcular el proyecto. 


8. Seleccione Proyecto> Calcular proyecto. O presione la tecla F4. 


Tenga en cuenta que ahora los indicadores aparecen en los puntos 5 y fsi en la 
Vista de plano. 


 


9. Seleccione Ver > Panel Indicadores. 
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En el Panel de indicadores, puede ver que los dos puntos exceden las tolerancias 
de los puntos horizontales que se especificaron para el proyecto.  


 


Para este tutorial, usted cambiará la tolerancia para que sea menos restrictiva y que 
los indicadores no aparezcan más.  


10. Para cambiar las tolerancias horizontales y verticales para los puntos del proyecto, 
realice lo siguiente: 


a. Seleccione Proyecto > Configuraciones del proyecto. O haga clic en el icono 
Configuraciones del proyecto  en la barra de herramientas. 


b. En diálogo Configuraciones del proyecto, seleccione Cálculos en el panel de 
navegación que se encuentra en el lado izquierdo del diálogo. 


c. En la sección Calidad de levantamiento, cambie el campo Tolerancia 
horizontal (levantamiento) a 0,025 m. Cambie el campo Tolerancia horizontal 
(levantamiento) a 0,055 m. 


d. Haga clic en  Aceptar. 


Los indicadores ya no aparecen en la Vista de plano o el Panel indicadores. 


11. Para ver solamente las observaciones y líneas base habilitadas (para 
posprocesamiento) en la Vista de plano, realice lo siguiente: 


a. Seleccione la Vista de plano 


b. Seleccione Ver > Administrador de filtros de vista. 


Aparecerá el Administrador de filtros de vista. 


 


c. Seleccione la ficha Observaciones en el área inferior del panel, y seleccione la 
opción Sólo observaciones habilitadas. 


d. Seleccione la ficha Tipos de datos GNSS en el área inferior del panel, y 
seleccione la opción Sólo observaciones habilitadas (para 
posprocesamiento). 
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e. Haga clic en la Vista de plano y use la rueda del ratón para realizar un 
acercamiento. Presione la rueda del ratón y muévalo para centrar los puntos 
como se muestran en la segunda figura. 


Vista de plano antes de filtrar la vista: 


 


Vista de plano después de filtrar la vista: 


 


Terminó de deshabilitar las líneas base dependientes de su proyecto. 


12. Seleccione Archivo > Cerrar proyecto. 


Aparecerá el diálogo Guardar cambios. Si guardó el proyecto en una nueva 
ubicación o con otro nombre, puede hacer clic en Sí. De lo contrario, haga clic en 
No. 
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Acerca de este tutorial 
En este tutorial, configurará un nuevo proyecto, seleccionará varias configuraciones de 
proyecto y lo guardará como una plantilla que se puede utilizar para otros proyectos. 


Nota: Si en cualquier momento necesita ayuda adicional mientras utiliza el software, 
presione F1 para ver la ayuda en línea. 


Paso 1. Crear un proyecto nuevo 
1. En la barra de menú de Trimble Business Center, seleccione Archivo > Nuevo 


proyecto. 


Aparecerá el diálogo Proyecto nuevo. 


 


2. Asegúrese de que en la lista esté seleccionado <Plantilla en blanco> y haga clic en 
Aceptar. 
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La Vista de plano muestra la ventana Trimble Business Center. Ahora está listo 
para seleccionar los ajustes de configuración para su proyecto. 


 


Nota: Esta figura muestra la Vista de plano con un fondo blanco. Su fondo puede 
estar en negro. Si desea cambiarlo a blanco, seleccione Herramientas > Opciones 
y seleccione Color de fondo: Blanco en el diálogo Opciones. 


Paso 2. Seleccionar las configuraciones del proyecto 
Puede seleccionar una gran variedad de opciones de configuración para su nuevo 
proyecto. Para este tutorial, especificará varias opciones configuración de proyecto de 
Sistema de coordenadas, Unidad, Procesamiento de líneas base y Vista. Para todas 
las demás opciones de configuración de proyecto, mantendrá los valores 
predeterminados. 
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Para abrir el diálogo Configuraciones del proyecto, seleccione Proyecto > 
Configuraciones del proyecto. O haga clic en el icono Configuraciones del proyecto 


 en la barra de herramientas. 


 


 


2a. Seleccionar la configuración del sistema de coordenadas 
En este paso, seleccionará el sistema de coordenadas que desea usar para su proyecto. 


1. En el panel de navegación (izquierdo) del diálogo Configuraciones del proyecto, 
seleccione Sistema de coordenadas. 


2. Haga clic en el botón Cambiar. 
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Si ha seleccionado previamente un sistema de coordenadas, aparecerá el diálogo 
Seleccionar sistema de coordenadas con una lista de los sistemas utilizados con 
anterioridad. Si aparece este diálogo, haga clic en la opción Nuevo sistema y en el 
botón Siguiente. 


 


Si no se ha seleccionado sistemas con anterioridad o si hizo clic en la opción Nuevo 
sistema en el diálogo Seleccionar sistema de coordenadas, aparecerá el diálogo 
Seleccionar tipo de sistema de coordenadas. 


3. En el diálogo Seleccionar tipo de sistema de coordenadas, seleccione la opción 
Zona y sistema de coordenadas. Luego haga clic en el botón Siguiente. 


Aparecerá el diálogo Seleccionar zona de sistema de coordenadas. 
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4. Haga lo siguiente: 


a. En la lista Grupo de sistemas de coordenadas, seleccione Plano estatal 
estadounidense de 1983. 


b. En la lista Zona, seleccione Colorado Norte 0501. 


c. Haga clic en Siguiente. 


Aparecerá el diálogo Seleccionar modelo de geoide. 


 


5. Haga lo siguiente: 


a. Seleccione la opción de modelo de  Geoide predefinido. 


b. Seleccione GEOID03 (Conus) en la lista. 


El Coordinate System Manager es un programa utilitario independiente que le 
permite acceder a su base de datos del sistema de coordenadas (Current.csd). 
En Coordinate System Manager, es posible predefinir los modelos de geoide. 
El modelo predefinido se selecciona en el diálogo Seleccionar modelo de 
geoide. 


c. Haga clic en el botón Finalizar. 


Aparecerá el diálogo Configuraciones del proyecto, mostrando la información de 
coordenadas seleccionada en la sección Resumen del panel Sistema de 
coordenadas. 


2b. Seleccionar la configuración de unidades 
Usará la opción de configuración Unidades para seleccionar los tipos de unidades de 
coordenadas, distancia y hora GPS que desee usar en su proyecto. 
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1. En el panel de navegación (izquierdo) del diálogo Configuraciones del proyecto, 
seleccione Unidades > Coordenada. Luego, en la lista desplegable Orden de 
visualización, seleccione Norte, Este, Elevación. 


 


2. En el panel de navegación del diálogo Configuraciones del proyecto, seleccione 
Unidades > Distancia. Luego, en la lista desplegable Mostrar, seleccione Metro. En 
la lista desplegable Definición de pie, seleccione Pie topográfico de los EE.UU. 


3. En el panel de navegación del diálogo Configuraciones del proyecto, seleccione 
Unidades > Hora GPS. Luego, en la lista desplegable Mostrar, seleccione GPS. 


 


2c. Seleccionar la configuración de procesamiento de líneas 
base 


A continuación, introducirá valores horizontales y verticales que, si se exceden, harán 
que las líneas base reciban un indicador o fallen del todo. 


1. En el panel de navegación (izquierdo) del diálogo Configuraciones del proyecto, 
seleccione Procesamiento de líneas base > Calidad. 


 


2. Introduzca las propiedades de Criterios de aceptación del modo siguiente: 


a. Marque la casilla Si precisión horizontal e introduzca los siguientes valores: 
- Indicador: 0,020 m + 1,0 ppm 
- Falla: 0,050 m + 1,0 ppm 


b. Marque la casilla Si precisión vertical e introduzca los siguientes valores: 
- Indicador: 0,050 m + 1,0 ppm 
- Falla: 0,100 m + 1,0 ppm 
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2d. Seleccionar la configuración de vistas 
En este paso, cambiará el color de las líneas de cuadrícula que se muestran en la Vista 
de plano. También seleccionará incluir propiedades de cuadrícula/terreno en la Hoja de 
cálculo de puntos y los valores PDOP máximos para vectores posprocesados en la 
Hoja de cálculo de vectores. 


1. En el panel de navegación (izquierdo) del diálogo Configuraciones del proyecto, 
haga clic en Vista > Vista de plano > Definición de líneas de cuadrícula. 


 


2. En la lista desplegable Color de línea, seleccione Magenta. 


Esto cambiará a magenta las líneas de cuadrícula que se muestran en la Vista de 
plano, haciendo más fácil que se vean si, por ejemplo, visualiza fotografías.  


3. En el panel de navegación del diálogo Configuraciones del proyecto, haga clic en 
Vista > Hoja de cálculo de puntos. 


 


4. Avance a la sección Propiedades de cuadrícula/terreno y seleccione mostrar el 
Factor de escala combinada en la Hoja de cálculo de puntos. 
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5. En el panel de navegación (izquierdo) del diálogo Configuraciones del proyecto, 
haga clic en Vista > Hoja de cálculo de vectores. 


 


6. Avance a la sección Datos observados y seleccione mostrar el valor de PDOP 
máximo  en la Hoja de cálculo de vectores. 


7. Haga clic en Aceptar. 


Ha terminado de seleccionar las opciones de configuración del proyecto. A continuación, 
verá algunas opciones de personalización. 


Paso 3. Configurar opciones de visualización y 
personalización 


Al comenzar un nuevo proyecto, debe verificar que las opciones de visualización se 
establezcan adecuadamente.  


1. Seleccione Herramientas > Opciones. 
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Aparecerá el diálogo Opciones.   


 


Puede cambiar cualquiera de las opciones de este diálogo para mejorar si vista al 
trabajar en las diferentes visualizaciones del programa. Tenga en cuenta que los 
cambios que haga permanecerán, independientemente de los proyectos que abra, 
hasta que los vuelva a modificar. 


2. Haga clic en el botón Avanzadas para ver el diálogo Opciones gráficas 
avanzadas. 


Este diálogo le permite controlar cómo se muestran los elementos gráficos (por 
ejemplo, fotografías) en su proyecto. Si una imagen muy grande no se ve 
correctamente debido a limitaciones de memoria, puede intentar usar este diálogo 
para seleccionar un tamaño reducido para muestra que le permita verla bien. Para 
efectos de este tutorial, no hará ningún otro cambio. 


3. Haga clic en Cancelar para cerrar el diálogo Opciones gráficas avanzadas. Haga 
clic en Cancelar para cerrar el diálogo Opciones. 


4. Seleccione Herramientas > Personalizar. 
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Aparecerá el diálogo Personalizar. 


 


Tómese unos momentos para explorar las distintas fichas y botones de este diálogo. 
(No es necesario que haga ningún cambio por ahora.) 


 Ficha Barras de herramientas: Seleccione esta ficha para especificar qué 
barras de herramientas se muestran y cree nuevas barras de herramientas 
personalizadas. 


 Ficha Comandos: Seleccione esta ficha para "arrastrar y soltar" comandos 
directamente a un menú o barra de herramientas y reorganice comandos de 
menú y botones de barras de herramientas. 


 Ficha Opciones: Seleccione esta ficha para personalizar el aspecto de menús y 
barras de herramientas. 


 Ficha Herramientas personalizadas: Seleccione esta ficha para crear 
comandos para abrir otras herramientas instaladas en su computadora. 


 Ficha Guardar/Cargar: Seleccione esta ficha para crear y guardar diseños de 
menús y barras de herramientas. 


 Botón Teclado: Haga clic en este botón para administrar accesos directos del 
teclado. 


5. Haga clic en Cerrar para cerrar el diálogo Personalizar. 


Ahora es un buen momento para guardar su proyecto y darle un nuevo nombre. 
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Paso 4. Guardar su proyecto 
1. Seleccione Archivo > Guardar proyecto .O haga clic en el icono Guardar proyecto 


 en la barra de herramientas. 


2. En el diálogo Guardar como, vaya hasta ..\Mis documentos\Trimble Business 
Center, que es la ubicación típica para guardar archivos de proyecto en su 
computadora. 


3. En el campo Nombre de archivo, escriba Setting Up a Project SuNombre.vce. 
Luego haga clic en Guardar. 


Se abrirá la ventana Trimble Business Center con el nombre del nuevo proyecto en 
la barra de título. 


 


El siguiente procedimiento explica cómo guardar su nuevo proyecto a una plantilla que 
pueda ser usada para otros proyectos. 


Paso 5. Crear una plantilla del proyecto 
Si espera crear futuros proyectos que se localicen dentro de la misma área geográfica 
que se usará para su nuevo proyecto, puede guardar las opciones de configuración de 
su proyecto como una plantilla de proyecto. 


1. Seleccione Archivo > Guardar proyecto como plantilla. 


Aparecerá el diálogo Guardar proyecto como plantilla. 
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2. En el nuevo campo Nombre, escriba Configurar plantilla. 


Puede marcar la casilla de verificación Guardar proyecto como plantilla por 
defecto para especificar que los nuevos proyectos usen de manera predeterminada 
esta plantilla de proyecto. 


No es necesario guardar una plantilla de proyecto basada en este tutorial. Así, en el 
siguiente paso, en lugar de hacer clic en Guardar como lo haría normalmente para 
guardar la plantilla, hará clic en Cerrar. 


Nota: Tras guardar una plantilla, puede seguir modificándola según sea necesario 
(por ejemplo, cambiar opciones de proyecto adicionales). Estas modificaciones se 
incluirían en la plantilla la próxima vez que la use. 


3. Haga clic en Cerrar para cerrar el diálogo sin guardar la plantilla. 


4. Seleccione Archivo > Cerrar proyecto. 
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Acerca de este tutorial 
En este tutorial, verá hojas de cálculo, creará un conjunto de selección y trabajará con 
controles COGO. 


Nota: Si en cualquier momento necesita ayuda adicional mientras utiliza el software, 
presione F1 para ver la ayuda en línea. 


Paso 1. Abrir un proyecto. 
Para este tutorial, usará el archivo de proyecto Using Spreadsheets.vce. Ya importaron 
GNSS, estación total y datos de nivel al proyecto y se procesaron las líneas base GNSS. 


1. En la barra de menú de Trimble Business Center, seleccione Archivo > Abrir 
proyecto. O haga clic en el icono Abrir proyecto  en la barra de herramientas. 


2. En el diálogo Abrir archivo, vaya a C:\Trimble Tutorials\TBC\Projects\ Using 
Spreadsheets.vce y haga clic en Abrir. 


Si instaló el tutorial en una ubicación distinta a la predeterminada que se muestra 
aquí, navegue hasta esa ubicación. 
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El proyecto se abre en la ventana de Trimble Business Center. 


 


Nota: Esta figura muestra la Vista de plano con un fondo blanco. Su fondo puede 
estar en negro. Si desea cambiarlo a blanco, seleccione Herramientas > Opciones 
y seleccione Color de fondo: Blanco en el diálogo Opciones. 


El archivo de proyecto es de sólo lectura. Puede realizar los pasos del tutorial sin 
guardar el archivo del proyecto. Sin embargo, si sufre una interrupción mientras sigue el 
tutorial, puede guardarlo al seleccionar Archivo > Guardar proyecto como y guardarlo 
en ..\Mis documentos\Trimble Business Center, que es la ubicación típica para 
guardar archivos de proyectos en su computadora. Tras ello, puede volver a abrir el 
proyecto para proseguir con el tutorial más adelante. 


Ahora, está preparado para explorar algunas de las características de Trimble Business 
Center. 


Paso 2. Ver hojas de cálculo 
En este paso, verá dos hojas de cálculo disponibles en Trimble Business Center: 


 Hoja de cálculo de ocupación 


 Hoja de cálculo de puntos 


Para personalizar lo que se muestra en las hojas de cálculo y cómo se muestra, siga 
estos pasos:  
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1. Seleccione Proyecto > Configuraciones del proyecto. O haga clic en el icono 
Configuraciones del proyecto  en la barra de herramientas. 


2. En el panel de navegación (izquierdo) del diálogo Configuraciones del proyecto, 
seleccione Ver > Hoja de cálculo de puntos. 


La tabla mostrará una lista de nombres de columnas que están disponibles para la 
hoja de cálculo de puntos. Después de cada nombre de columna existe un indicador 
que señala si la columna se debe incluir en la hoja de cálculo. 


 


Puede hacer clic en cualquiera de los indicadores Mostrar/Ocultar para cambiar la 
selección. 


En el panel de navegación (izquierdo) en el diálogo Configuraciones del proyecto, 
puede seleccionar otras hojas de cálculo en el menú Ver para ver y cambiar la 
configuración Mostrar/Ocultar de sus respectivas columnas. Para este tutorial, no 
es necesario realizar cambios. 


3. Haga clic en Cancelar para cerrar el diálogo Configuración del proyecto. 


A continuación, aprenderá a personalizar el orden de las columnas de una hoja. 


4. Seleccione Vista> Nueva hoja de cálculo de puntos. O bien, haga clic en el icono 
Nueva hoja de cálculo de puntos  en la barra de herramientas. 


Aparecerá una Hoja de cálculo de puntos. 
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Puede ordenar las columnas de la hoja de cálculo de acuerdo con el encabezado 
que seleccione. De manera predeterminada, las columnas se encuentran en orden 
alfabético ascendente de acuerdo con la ID de punto. 


5. Haga clic en el encabezado de columna Elevación para ordenar las columnas de 
acuerdo con la elevación ascendente y descendente de los puntos. 


El icono Orden  indica si el orden es ascendente (la flecha apunta hacia arriba) o 
descendente (la flecha apunta hacia abajo). 


Para filtrar las columnas visibles, haga clic en el icono de filtro  de una columna y 
seleccione el filtro que desee. El filtro predeterminado es Todo. 


6. Haga clic en el icono del filtro Código de característica  y seleccione No en 
blanco en el menú de contexto. 


 


En la hoja de cálculo se mostrarán solo los puntos a los que haya asignado códigos 
de características. 


Además, existen otras maneras en las que puede personalizar la hoja de cálculo: 


 Para redimensionar el ancho de cualquier columna, coloque el cursor en el 
borde del encabezado de la columna y arrástrelo hacia la izquierda o la derecha. 


 Para mover una columna a otra ubicación, utilice el método de arrastrar y soltar. 


 Para mover la ficha de la hoja de cálculo a otra ubicación. Simplemente, haga 
clic en la etiqueta de la ficha y arrástrela hacia abajo, fuera de la barra de fichas, 
y suéltela. Luego, seleccione una de las ubicaciones que aparecen en el menú 
de contexto. 


Seleccione Nuevo grupo de fichas vertical para mostrar verticalmente la ficha 
en la ventana. 


Use el mismo procedimiento para regresar la ficha a su ubicación original. 


Todos los contenidos que se muestren con color azul en la hoja de cálculo se 
pueden editar. Por ejemplo, puede introducir una nueva ID de punto o puede editar 
un Código de característica directamente en la columna o haciendo clic en  para 
mostrar el diálogo Editor de códigos de características. 


Puede copiar columnas de una hoja de cálculo a una hoja de cálculo de Microsoft 
Excel. Simplemente, seleccione las columnas que desea copiar, presione Ctrl+C 
para copiarlas, seleccione una celda en la hoja de cálculo de Excel y presione 
Ctrl+V para pegarlas. Aunque el encabezado de la columna no se puede 
seleccionar, siempre se copia y pega en la hoja de cálculo junto con las columnas 
que seleccione. 


Para mostrar el panel Propiedades de cualquier punto, seleccione la columna haga 
clic con el botón secundario y seleccione Propiedades en el menú de contexto. 


Los filtros personalizados permiten seleccionar criterios para filtrar los datos que se 
muestran en una hoja de cálculo. En el siguiente ejemplo, seleccionará sólo ver los 
puntos no que utilizaron el tipo de antena R8 GNSS/SPS88x Internal. 
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7. Seleccione Vista> Nueva hoja de cálculo de ocupación. O bien, haga clic en el 
icono Nueva hoja de cálculo de ocupación  en la barra de herramientas. 


Aparecerá la Hoja de cálculo de ocupación. 


 


8. Haga clic en icono de filtro Tipo de antena  y seleccione Personalizado en el 
menú de contexto. 


Aparecerá el diálogo Introducir criterios de filtro para el tipo de antena. 


 


9. En la lista desplegable Operador, seleccione No es igual a. 


10. En la lista desplegable Operando, seleccione R8 GNSS/SPS88x Internal. Luego, 
haga clic en Aceptar. 


La hoja de cálculo se actualiza de acuerdo con su filtro personalizado. Sólo se 
muestran los puntos que no utilizaron el tipo de antena R8 GNSS/SPS88x Internal. 


 
Acaba de finalizar la revisión de las hojas de cálculo. A continuación, aprenderá cómo 
crear y utilizar conjuntos de selección. 
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Paso 3. Crear un conjunto de selección 
Si usted necesita seleccionar los mismos objetos una y otra vez, puede ser frustrante 
hacerlo manualmente, lo que además se presta a pueda cometer errores. En lugar de 
ello, use el Explorador de selecciones para crear conjuntos de selección reutilizables. 


1. Haga clic en la Vista de plano. 


2. Utilice el icono Acercar  en la barra de herramientas para agrandar la vista, como 
se muestra aquí. Si lo prefiere, haga clic en la Vista de plano y use la rueda del 
ratón para acercarse. Presione la rueda del ratón y muévalo para centrar los puntos. 


 


3. Seleccione Ver > Explorador de selecciones. O haga clic en el icono Explorador 
de selecciones  en la barra de herramientas. 
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Aparecerá el panel Explorador de selecciones. 


 


El Explorador de selecciones contiene dos listas: 


 La lista Conjuntos de selección en la mitad superior del panel. 


 La lista de objetos se encuentra en la mitad inferior del panel y muestra los 
objetos seleccionados en la Vista de plano o los que se encuentran dentro de 
los conjuntos de selección que se haya seleccionado. 


4. En la Vista de plano, use el cursor para crear un cuadro de selección alrededor del 
grupo de objetos que desea incluir en su conjunto de selección, como se muestra 
aquí. 
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Sus selecciones se muestran en el Explorador de selecciones en la lista de objetos 
<Instantánea de selección>. 


 


5. En la barra de herramientas del Explorador de selecciones, haga clic en el icono 
Guardar la lista de selección como . 


6. En el diálogo Guardar <Instantánea de selección> como, introduzca un nombre 
para su conjunto de selección: Selección SuNombre. Luego, haga clic en Aceptar. 


Su nuevo conjunto de selección se añadirá a la lista Conjuntos de selección. Para 
ver los objetos que se incluyen en su conjunto de selección, simplemente seleccione 
el conjunto en la lista Conjuntos de selección. 
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Para ver las propiedades de cualquier objeto en el conjunto de selección, 
selecciónelo en la lista, haga clic con el botón secundario y seleccione Propiedades 
en el menú de contexto. Para seleccionar múltiples objetos, use Ctrl + clic o Mayús 
+ clic. La selección de múltiples objetos puede ser particularmente útil si desea 
especificar una propiedad (por ejemplo, un código de característica) para todos ellos 
al mismo tiempo. 


Para seleccionar los objetos de múltiples conjuntos de selección, presione la tecla 
Ctrl y haga clic en los conjuntos que desea seleccionar en la lista Conjuntos de 
selección. 


Puede usar los otros iconos de la barra de herramientas del Explorador de 
seleccionas para ver las propiedades de los objetos seleccionados, eliminar 
conjuntos de selección y añadir o eliminar objetos en ellos. Para ver instrucciones, 
consulte la Ayuda en línea. 


7. Cierre el panel Explorador de selecciones. 


Ha terminado de trabajar con conjuntos de selección. A continuación, conocerá algunos 
controles COGO que le serán de utilidad. 


Paso 4. Trabajar con controles COGO 
Los controles COGO (de COordinate GeOmetry, o Geometría de Coordenadas) son los 
cuadros en varios comandos que ayudan a calcular ángulos, rumbos, coordenadas, 
distancias, elevaciones y desajustes en su proyecto. Permiten introducir datos de varias 
maneras, como: 


 Escribir valores e IDs de puntos en el cuadro 


 Seleccionar puntos en vistas gráficas 


 Hacer clic con el botón secundario del ratón en vistas gráficas y seleccionar del 
menú de contexto opciones COGO y de selección adicionales 


Los controles COGO le ofrecen esta flexibilidad de uso para que usted tenga a su 
disposición varias maneras de introducir datos al interior de un solo comando, en lugar 
de estar obligado a utilizar varios comandos distintos. 


Los comandos de selección COGO usan cálculos geométricos para ayudarle a 
especificar y seleccionar coordenadas de manera más fácil y precisa. Los comandos de 
selección pueden calcular un punto de selección utilizando la geometría existente o 
parámetros que usted introduzca. Los comandos de selección están disponibles en 
cualquier momento en que necesite introducir una coordenada. Simplemente, haga clic 
con el botón secundario para ver las opciones. 


En el siguiente procedimiento, creará cuatro nuevos puntos en el proyecto (1, 2, 6 y 7) 
utilizando varios controles COGO y comandos de selección disponibles en Trimble 
Business Center. Sin embargo, antes de crear nuevos puntos debe verificar que las 
opciones del modo de selección estén configuradas correctamente. 
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1. Haga clic en el botón Selección en la barra de estado, en la parte inferior de la 
ventana de Trimble Business Center. 


 


Aparecerá el diálogo Opciones de modos de selección activos. 


 


Este diálogo le permite especificar opciones de modos de selección. El diálogo 
muestra una descripción de cada opción. 


En este procedimiento, utilizará comandos de selección para seleccionar puntos. 
Para asegurarse de que selecciona un punto y no una coordenada cercana a un 
punto, quite la selección del modo Libre. Sin embargo, y debido a que esta 
selección es una configuración de sistema y no específica del proyecto, cuando 
finalice este procedimiento deberá volver a seleccionar Libre. 


2. En el diálogo Opciones de modos de selección activos, haga lo siguiente: 


a. Verifique que la opción de modo Punto esté seleccionada. 


b. Quite la selección de la opción de modo Punto. 


c. Haga clic en Aceptar. 


3. Para crear el punto 1, siga estas instrucciones: 


a. Seleccione Punto > Crear punto. 


Aparecerá el panel Crear punto. 
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b. Asegúrese de que el campo ID de punto muestre el valor 1, que el campo 
Código de característica esté en blanco y que el campo Tipo de coordenada 
sea Cuadrícula. 


c. Haga clic con el botón secundario en el campo Valor norte. 


d. En el menú de contexto, seleccione Selección de distancia de rumbo. 


Aparecerá el panel Selección de distancia de rumbo. Estos controles le 
permiten calcular un punto basado en un punto de origen, un rumbo y una 
distancia. El rumbo cero (0) es el norte, y los rumbos utilizan acimuts de 
cuadrícula que se miden hacia la derecha. 


 


e. Haga clic en el campo Punto de referencia y luego haga clic en el punto 5 en la 
Vista de plano. 


Se mostrará la coordenada del punto 5 en el campo. Si lo prefiere, puede 
simplemente escribir 5 en el campo. 


f. En el campo Rumbo, introduzca S37 44 56E (o campo Acimut = 142 15 04). 


g. En el campo Distancia, introduzca 290.91 pies topográficos. Luego, haga clic en 
Aceptar. 


Tenga en cuenta que el valor especifica la distancia en pies topográficos. Esto 
es necesario si un valor que introduzca se encuentra en una unidad distinta de la 
que se especificó en el diálogo Configuraciones de proyecto. 
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Las coordenadas para el nuevo punto 1 se muestran en el panel Crear punto. 


 


h. Haga clic en el botón Añadir. 


El nuevo punto 1 se muestra en la Vista de plano. El panel Crear punto vuelve 
a su estado original para que pueda crear un nuevo punto. 


 


4. Para crear el punto 2, siga estas instrucciones: 


a. En el panel Crear punto, asegúrese de que el campo ID de punto muestra el 
valor 2. 


b. Haga clic con el botón secundario en el campo Distancia hacia el norte 
(northing). 


c. En el menú de contexto, seleccione Selección de distancia de rumbo. 
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Aparecerá el panel Selección de distancia de rumbo. 


 


d. En el campo Punto de referencia, escriba 3. 


e. En el campo Rumbos, escriba N18 05 08E. 


f. En el campo Distancia, introduzca 322.91 pies topográficos. Luego, haga clic en 
Aceptar. 


Las coordenadas para el nuevo punto 2 se muestran en el panel Crear punto. 


g. Haga clic en el botón Añadir. 


El nuevo punto 2 se muestra en la Vista de plano. 


 


Ahora, está preparado para crear el nuevo punto 6, que se ubicará en el punto 
medio entre los puntos 1 y 2. 


5. Para crear el punto 6, siga estas instrucciones: 


a. En el panel Crear punto, introduzca el valor 6 en el campo ID de punto. 


b. Haga clic con el botón secundario en el campo Distancia hacia el norte 
(northing). 


c. En el menú de contexto, seleccione Selección de Punto medio entre puntos. 
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Aparecerá el panel Selección de Punto medio entre puntos. Estos controles 
permiten calcular el punto medio entre dos puntos. 


 


d. En el campo Punto de origen, escriba 1. 


e. En el campo Punto de destino, escriba 2. Luego, haga clic en Aceptar. 


Las coordenadas para el nuevo punto 6 se muestran en el panel Crear punto. 


f. Haga clic en el botón Añadir. 


El nuevo punto 6 se muestra en la Vista de plano. 


 


Ahora está listo para crear un nuevo punto 7. 


6. Para crear el punto 7, siga estas instrucciones: 


a. En el panel Crear punto, asegúrese de que el campo ID de punto muestra el 
valor 7. 


b. Haga clic con el botón secundario en el campo Distancia hacia el norte 
(northing). 


c. En el menú de contexto, seleccione Selección de rumbo a rumbo. 
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Aparecerá el panel Selección de rumbo a rumbo. Estos controles le permiten 
calcular la intersección de dos rumbos definidos por un primer punto y un 
segundo punto. 


 


d. En el campo Punto de referencia 1, escriba 5. 


e. Haga clic con el botón secundario en el campo Rumbo 1. 


f. En el menú de contexto, seleccione Selección de Rumbo+ ángulo. 


Aparecerá el panel del comando Selección de Rumbo+ ángulo. Estos 
controles le permiten calcular un rumbo añadiendo un ángulo a un rumbo dado. 


 


g. Haga clic con el botón secundario en el campo Rumbo. 


h. En el menú de contexto, seleccione Selección de rumbo punto a punto. 
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Aparecerá el panel del comando Selección de rumbo punto a punto. Estos 
controles le permiten calcular el rumbo desde un punto a otro. 


 


i. En el campo Punto de referencia 1, escriba 5 


j. En el campo Punto de referencia 2, escriba fsi. Luego, haga clic en Aceptar. 


Aparece el panel Selección de Rumbo+ ángulo mostrando el nuevo Rumbo 1. 


 


k. En el campo Ángulo, escriba 5 (para 5 grados). Luego, haga clic en Aceptar. 


Aparecerá el panel Selección de rumbo a rumbo. 


 


l. En el campo Punto de referencia 2, escriba 3. 


m. Haga clic con el botón secundario en el campo Rumbo 2. 
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n. En el menú de contexto, seleccione Selección de rumbo punto a punto. 


Aparecerá el panel Selección de rumbo punto a punto. 


 


o. En el campo Punto de referencia 1, escriba 3. 


p. En el campo Punto de referencia 2, escriba 6. Luego, haga clic en Aceptar. 


Aparece el panel Selección de rumbo a rumbo mostrando el nuevo Rumbo 2. 


 


q. Haga clic en  Aceptar. 
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Las coordenadas para el nuevo punto 7 se muestran en el panel Crear punto. 


 


r. Haga clic en el botón Añadir. 


El nuevo punto 7 se muestra en la Vista de plano. 


 


Ahora, puede volver a seleccionar la opción de modo de selección Libre en caso de 
que necesite habilitarla para otros proyectos. 


7. Para volver a seleccionar la opción de modo de selección Libre, siga estas 
instrucciones: 


a. Haga clic en el botón Selección en la barra de estado, en la parte inferior de la 
ventana de Trimble Business Center. 


b. En el diálogo Opciones de modos de selección activos, seleccione Libre. 


c. Haga clic en  Aceptar. 
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Ha terminado de trabajar con controles COGO. Ahora, puede seguir explorando el 
software Trimble Business Center. Cuando lo necesite, presione F1 para ver la 
Ayuda en línea. 


8. Cuando haya terminado de explorar el software, seleccione Archivo > Cerrar 
proyecto. 


Aparecerá el diálogo Guardar cambios. Si guardó el proyecto en una nueva 
ubicación o con otro nombre, puede hacer clic en Sí. De lo contrario, haga clic en 
No. 
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Acerca de este tutorial 
Un "corredor" es un modelo 3D de una estructura lineal, como una carretera o vía fluvial. 
El corredor se basa en una alineación horizontal y (opcionalmente) vertical e incluye 
plantillas que definen secciones transversales y transiciones a su largo. 


En este tutorial, creará un corredor de carretera en base a una superficie y alineación 
existentes. 


Notas: 


 Para crear un corredor con capas de materiales como se describe en este tutorial, 
debe tener en ejecución el software Trimble Business Center con la licencia de 
producto Survey Advanced. La licencia de producto Survey Standard sólo permite 
crear un corredor sin capas de materiales. Para comprobar la licencia de producto 
para su instalación, seleccione Ayuda > Acerca de Trimble Business Center y 
haga clic en el botón Licencia. Las funciones con licencia se muestran en la lista 
Funciones. 


 Si en cualquier momento necesita ayuda adicional mientras utiliza el software, 
presione F1 para ver la ayuda en línea. 


 


Paso 1. Abrir un proyecto. 
Para este tutorial, usará el archivo de proyecto Working with Corridors.vce. Este proyecto 
contiene una superficie y una alineación para crear un nuevo corredor de carretera. 


1. En la barra de menú de Trimble Business Center, seleccione Archivo > Abrir 
proyecto. O haga clic en el icono Abrir proyecto  en la barra de herramientas. 


2. En el diálogo Abrir archivo, vaya a C:\Trimble Tutorials\TBC\Projects\Working 
with Corridors.vce y haga clic en Abrir. 


Si instaló el tutorial en una ubicación distinta a la predeterminada que se muestra 
aquí, navegue hasta esa ubicación. 
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El proyecto se abre en la ventana de Trimble Business Center. 


 


Nota: Esta figura muestra la Vista de plano con un fondo blanco. Su fondo puede 
estar en negro. Si desea cambiarlo a blanco, seleccione Herramientas > Opciones 
y seleccione Color de fondo: Blanco en el diálogo Opciones. 


El archivo de proyecto es de sólo lectura. Puede realizar los pasos del tutorial sin 
guardar el archivo del proyecto. Sin embargo, si sufre una interrupción mientras sigue el 
tutorial, puede guardarlo al seleccionar Archivo > Guardar proyecto como y guardarlo 
en ..\Mis documentos\Trimble Business Center, que es la ubicación típica para 
guardar archivos de proyectos en su computadora. Tras ello, puede volver a abrir el 
proyecto para proseguir con el tutorial más adelante. 


Paso 2. Seleccione el tipo de porcentaje de pendiente 
para el proyecto 


Puesto que los corredores incluyen pendientes, debe verificar que el tipo de porcentaje 
de pendiente para su proyecto sea el correcto. El tipo puede ser de elevación a trayecto 
(rise-to-run) o de trayecto a elevación (run-to-rise). 


1. Seleccione Proyecto > Configuraciones del proyecto. 
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2. En el diálogo Configuración del proyecto, haga clic en Unidades > Ángulo 
vertical en el panel izquierdo. 


 


Observe que el Tipo de porcentaje de pendiente está establecido como Elevación 
a trayecto. Esta es la configuración que desea usar para este tutorial, por lo que no 
es necesario que haga ningún cambio. 


3. Haga clic en el botón Cancelar. 
 


Paso 3. Filtrar la vista 
Para ver mejor la alineación y la superficie incluidos en el proyecto, puede filtrar la vista 
para que oculte los puntos y vectores RTK. 


1. Seleccione Ver > Administrador de filtros de vista. 


El panel Administrador de filtros de vista muestra que todos los objetos de Datos 
brutos están seleccionados para su visualización. 


 


2. En la lista Datos brutos, quite la selección de Vector RTK y Punto. 
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Puede ver el cambio en la Vista de plano. 


 


3. Cierre el panel Administrador de filtros de vista. 
 


Paso 4. Crear nombres de nodos de plantilla 
Antes de crear un nuevo corredor, puede crear nombres que se usarán para identificar 
nodos en plantillas de sección transversal de corredores. 


También puede crear nombres de nodos de plantilla cuando esté creando plantillas de 
corredor, pero crearlos por anticipado puede ayudar a acelerar el proceso de creación de 
plantillas. También permite crear una biblioteca de nombres de nodos que se puede usar 
una y otra vez en cada uno de sus proyectos. Sencillamente, cree los nombres que 
pueda necesitar y luego guarde su proyecto como una plantilla. Los nombres estarán 
disponibles para cualquier proyecto creado utilizando la plantilla. Para ver instrucciones 
sobre cómo crear plantillas de proyecto, consulte el tutorial Configurar un nuevo 
proyecto. 


En este procedimiento creará dos nuevos nombres de nodos de plantilla. 


1. Seleccione Corredor > Nombres de nodos de plantillas de corredor. O haga clic 
en el icono Administrar nombres de nodos de plantilla  en la barra de 
herramientas. 


2. En el panel Administrar nombres de nodos de plantilla, haga clic en el botón 
Nuevo ubicado en la parte inferior del panel. (Puede ser necesario que avance hacia 
abajo para verlo.) 
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Aparece una nueva fila en la lista. 


 


3. Escriba Vía de tráfico.  


4. Repita los pasos 2 y 3 para crear el nombre Punto de unión. 


5. Haga clic en el botón Cerrar. 


A continuación, creará una nueva capa de material para el corredor. 


Paso 5. Crear capas de material 
Puede especificar las capas de material disponibles en su proyecto, cada una 
representando una superficie distinta dentro del corredor. Por ejemplo, además de la 
capa de "Acabado" predeterminada, puede especificar capas para "Ruta base", 
"Subnivel estabilizado" y "Subnivel". 


Cada vez que cree una instrucción de plantilla de corredor (como se describe más 
adelante en este tutorial) puede seleccionar una o más capa(s) de material en que 
aparece el segmento de línea creado por esa instrucción. 


Al crear o editar un corredor, puede especificar su "capa de material actual", 
seleccionándola de la lista Capas. Esta es la capa que aparecerá en la Vista de plano y 
la Vista 3D. Si exporta el corredor, esta será la capa que se utilice para crear la 
superficie de corredor exportada. Los segmentos de línea que aparezcan en la capa de 
material actual se usan para crear la superficie de corredor. 


En este procedimiento, creará una nueva capa de material a utilizar en el corredor. 


1. Seleccione Corredor > Administrar capas de material. O haga clic en el icono 
Administrar capas de material  en la barra de herramientas. 


Aparecerá el panel Administrar capas de material. La capa Acabado 
predeterminada aparece en la lista Capas de material. 


 


2. Haga clic en el botón Nuevo. 


Aparecerá una nueva fila en la lista Capas de material. 
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3. En el campo Nombre, escriba Subnivel. 


4. Haga clic en el botón Cerrar. 


Ahora está listo para crear un nuevo corredor. 


Paso 6. Crear un corredor. 
En este procedimiento, creará un corredor para una carretera que se va a construir en 
base a la superficie y la alineación incluidas en el proyecto. 


1. Seleccione Corredor > Editar corredor. O haga clic en el icono Crear corredor  
en la barra de herramientas. 


Aparecerá el panel del comando Crear corredor. 


 


2. En el campo Nombre, escriba Carretera01 


LC (línea de centro, o "CL" para "Centerline" en inglés)es la única alineación en el 
proyecto, por lo que está seleccionada de manera predeterminada en las listas 
desplegables Alineación horizontal y Alineación vertical. 


3. En la lista Capa de material actual, seleccione Acabado. 


Esta es la capa que aparecerá en la Vista de plano y la Vista 3D. 


Ahora seleccionará una polilínea CAD que se incluye en el proyecto como línea de 
referencia en el nuevo corredor. Podrá crear desajustes en el corredor, basándose 
en esta línea. 


4. Haga clic en el botón +/-. 
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Aparecerá el panel del comando Editar líneas de referencia. 


 


5. Haga clic en el campo Líneas seleccionadas que añadir o quitar. Luego, haga clic 
en la polilínea CAD agua en la Vista de plano. En el menú de contexto, seleccione 
Polilínea CAD. 


Si es necesario, use la rueda del ratón para acercar y ver mejor la línea. 


 


El campo muestra que hay seleccionado un elemento. 


 


6. Haga clic en el botón Añadir. 


Aparecerá un mensaje indicando que el elemento seleccionado se añadió como 
línea de referencia al nuevo corredor. 


7. Haga clic en el botón Cerrar. 
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La cantidad de líneas de referencia que se incluirán en el corredor se indica en el 
panel Crear corredor.  


 


8. En la lista Superficies de referencia, marque la casilla existentes. 


9. Haga clic en  Aceptar. 


Aparecerá el panel Insertar plantilla de corredor. 


 


A continuación, insertará una plantilla de sección transversal en el nuevo corredor. 


Paso 7. Insertar una plantilla de corredor 
Puede crear e insertar una o más plantillas de sección transversal en un corredor. (Sin 
embargo, no puede insertar más de una plantilla en la misma estación). Cada plantilla 
incluye instrucciones que definen secciones transversales para una longitud especificada 
del corredor (por ejemplo, los distintos desajustes y pendientes para una carretera). 


En este procedimiento, creará una plantilla simple que define el corredor desde la 
estación 0+00 en adelante. 


1. En el panel Insertar plantilla de corredor, asegúrese de que esté seleccionado 
Carretera01 en la lista desplegable Corredor. 


2. En el campo Estación inicial, escriba 0. 


Observe que cuando mueve el cursor desde el campo, el 0 cambia al formato de 
estacionamiento estándar: 0+00.00. Esto indica que la nueva plantilla se insertará en 
la estación 0+00.00 en el corredor y se usará para definir el corredor desde esta 
estación a la nueva plantilla o, si no hay ninguna, al final del corredor. 
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3. En la lista desplegable Opciones, asegúrese de que esté seleccionado Nueva 
definición. 


4. En el campo Nombre de plantilla, escriba Plantilla01. 


 


5. Haga clic en el botón Insertar. 


Aparecerá el panel Editar plantilla de corredor. El panel incluye tres secciones: (1) 
una ficha de vista gráfica de la plantilla, (2) una lista de Instrucciones y (3) una 
sección de propiedades de instrucciones. 
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En la ficha de vista gráfica, la línea verde representa la superficie en el proyecto. El 
nodo de línea de centro 1[LC], que se basa en la alineación horizontal, se creó y 
añadió a la plantilla automáticamente. También puede ver que se añadió un nodo 2 
(aproximadamente 15 pies a la izquierda de 1[LC]), en base a la polilínea CAD 
simple que añadió previamente al corredor. 


 


6. Seleccione Ver > Explorador del proyecto. Luego, en el panel Explorador del 
proyecto, haga clic en el signo más que está ante el nodo Corredores y el nodo 
Carretera01 para ver el nuevo nodo de plantilla. 


 


7. Cierre el panel Explorador del proyecto. 
 


Paso 8. Crear instrucciones para la plantilla de 
corredor 


Ahora que ha creado e insertado una plantilla de sección transversal en el nuevo 
corredor, puede definir instrucciones que especifiquen la apariencia de la sección 
transversal a lo largo del corredor para el que se ha definido la plantilla: los distintos 
desajustes y pendientes de la carretera. 
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Las plantillas de corredor están formadas por nodos e instrucciones. Los nodos se usan 
para definir los distintos desajustes y pendientes en las plantillas. Por ejemplo, un 
corredor de carretera simple podría contener tres nodos: una línea de centro basada en 
la alineación (1), un borde derecho del pavimento (2) y un borde izquierdo del pavimento 
(3). 


 


El software crea automáticamente algunos nodos basados en la alineación y las líneas 
de referencia de su corredor. Por ejemplo, el nodo 1 en la figura de arriba se creó 
automáticamente como línea de centro para el corredor, en base a la alineación del 
corredor. 


Puede crear nodos adicionales según sea necesario para definir desajustes y pendientes 
para otras características de corredor. Por ejemplo, el nodo 2 de la figura de arriba se 
creó manualmente para representar el borde derecho del pavimento con un desajuste de 
3 m y una pendiente de -2% con respecto a la línea de centro. Para crear un nodo de 
manera manual, debe definir las instrucciones que especifican el desajuste y la 
pendiente del nodo con respecto a otros nodos de la plantilla. 


En este procedimiento, definirá una plantilla de corredor al definir primero nodos y líneas 
para el lado derecho del corredor, para las capas de material Acabado y Subnivel. Tras 
ello, usará el comando Copiar instrucciones en espejo para copiar el mismo nodo y su 
diseño de líneas al lado izquierdo de la línea de centro. 


8a. Definir la vía de tráfico derecha – capa Acabado 
1. En el panel Editar plantilla de corredor, seleccione Desajuste/Pendiente en la 


lista desplegable Tipo de instrucción. 


Este tipo de instrucción le permite crear un nodo en la plantilla para la que 
especifique el desajuste y la pendiente en relación con otro nodo. En este caso, 
basará el nuevo nodo en el nodo de línea de centro (LC) que se creó 
automáticamente para la alineación seleccionada. 


2. En el campo Desajuste/Pendiente de origen, seleccione <Nodo anterior>. 


Si selecciona <Nodo anterior>, se hará referencia al nodo creado por la instrucción 
precedente en la lista Instrucciones. Si en la lista no hay instrucciones precedentes, 
como en este caso, se hace referencia al nodo 1[LC] creado automáticamente para 
la alineación horizontal. 


3. En el botón Desajuste, asegúrese de que aparezca el icono Desajuste  . Luego, 
introduzca 12 en el campo. 


Esto especifica que el nuevo nodo se creará a 12 pies (3 metros) a la izquierda del 
nodo 1[LC] (Línea de Centro, LC). Si hubiera escrito -12, el nuevo nodo se crearía a 
12 pies (3 metros) a la izquierda del nodo 1[LC]. 


4. En el botón Pendiente, haga clic en el icono desplegable y seleccione la opción 
Tabla   . Luego haga clic en el botón Tabla. . 
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Aparecerá el panel Tabla de estación/pendiente. Este panel le permite especificar 
la pendiente entre el nodo 1[LC] y el nuevo nodo en ubicaciones especificadas a lo 
largo del corredor, desde la plantilla actual a la plantilla siguiente (o el final del 
corredor). 


 


5. En el panel Tabla de estación/pendiente , ingrese los siguientes valores. 


Nota: No es obligatorio que escriba los valores en el formato que se muestra aquí. 
Para 0+00,00, simplemente puede ingresar 0. Para 4+33,00, puede ingresar 433. 
Para una pendiente de -2,00%, puede ingresar -2. El formato correcto se aplicará 
cuando su cursor salga de la celda de la tabla. 


Estación Pendiente 
0+00,00 -2,00% 
0+50,00 -2,00% 
0+75,00 -4,00% 
1+32,00 -4,00% 
1+50,00 -2,00% 
4+33,00 -2,00% 
4+53,00 -4,00% 
5+17,00 -4,00% 
5+36,00 -2,00% 


Un porcentaje de pendiente negativo indica crear el nodo bajo la línea de centro. 


 


Una vez que haya terminado, haga clic en Aceptar. 


6. En la lista desplegable Nombre, seleccione Vía de tráfico 


Este nodo representa el borde derecho de la vía de tráfico derecha. 
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7. En la lista Capas de material, seleccione Acabado. 


8. Haga clic en el botón Añadir.  


El nodo 3[Vía de tráfico] recién creado aparece en la vista gráfica de la plantilla. Las 
instrucciones utilizadas para crear el nodo aparecen en la lista Instrucciones. Haga 
clic en el área gráfica y use el ratón para acercar en el nuevo nodo. Observe también 
que ahora el corredor se muestra en la Vista de plano. 


 


Los campos de la sección de propiedades del panel Editar plantilla de corredor se 
han puesto en blanco para permitirle crear otra instrucción. 


8b. Definir la banquina derecha – capa Acabado 
1. En la lista desplegable Tipo de Instrucción, seleccione Desajuste/Pendiente. 


2. Complete los campos Detalles de instrucción como sigue: 


 Desajuste/Pendiente de origen: <Nodo anterior> 
En este caso, el  <Nodo anterior> es el nodo 3[Vía de tráfico] recién creado. 


 Desajuste > Desajuste :  6  


 Pendiente > Porcentaje de pendiente : -4 
En el botón desplegable Pendiente, seleccione la opción Porcentaje de 
pendiente. El signo menos que precede al número indica que la pendiente se 
encuentra en dirección descendente desde el nodo 3[Vía de tráfico]   


 Nombre: Banquina 
Puesto que no introdujo Banquina como código de corredor en el Administrador 
de códigos de corredor, puede escribirlo en el campo Código ahora. 
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 Capas de material: Acabado 


 


3. Haga clic en el botón Añadir. 


El nodo 4[Banquina] recién creado representa el borde derecho de la banquina, 
basándose en el borde derecho de la vía de tráfico. 


 


 


8c. Definir la pendiente de drenaje derecha – capa Acabado 
1. En la lista desplegable Tipo de Instrucción, seleccione Desajuste/Pendiente. 


2. Complete los campos Detalles de instrucción como sigue: 


 Desajuste/Pendiente de origen: <Nodo anterior> 
En este caso, el  <Nodo anterior> es el nodo 3[Banquina] recién creado. 


 Desajuste > Desajuste : -5 


 Pendiente > Porcentaje de pendiente : -20 
En el botón desplegable Pendiente, seleccione la opción Porcentaje de 
pendiente. El signo menos que precede al número indica que la pendiente se 
encuentra en dirección descendente desde el nodo 4[Banquina]. 
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 Nombre: Zanja 
Deberá escribir este nuevo código en el campo. 


 Capas de material: Acabado 


3. Haga clic en el botón Añadir. 


El nodo 5[Zanja] recién creado representa el borde derecho de la pendiente de 
drenaje, basándose en el borde derecho de la banquina. 


 


Ahora está listo para definir una pendiente lateral para el lado derecho de la plantilla 
de corredor. El tipo de instrucción Pendiente Lateral define un nodo de pendiente 
lateral basado en uno o ambos de los siguientes elementos: 


 Pendiente de desmonte y, de manera opcional, un ancho de zanja 


 Pendiente de terraplén 


El nodo de pendiente lateral especifica la intercepción de pendiente de desmonte o 
terraplén con la superficie de destino. 


8d. Definir la pendiente de drenaje lateral derecha  – capa 
Acabado 


1. En la lista desplegable Tipo de Instrucción, seleccione Pendiente Lateral. 


2. Complete los campos Detalles de instrucción como sigue: 


 Pendiente lateral de origen: <Nodo anterior> 
En este caso, el  <Nodo anterior> es el nodo 3[Zanja] recién creado. 


 Superficie de destino: existente 
Esto permite que la pendiente lateral conecte con la superficie existente. 


 Pendiente de desmonte > Porcentaje de pendiente : 1:2 
Basado en la configuración del proyecto, esto representa un tipo de pendiente 
de levantamiento a trayecto (rise-to-run). 


 Ancho de zanja de desmonte: 3 
Esto indica que se requiere un terraplén, se incluye una zanja de 3 pies (0,9 m) 
de ancho. 


 Pendiente de terraplén > Porcentaje de pendiente : 1:5 


 Nombre: Punto de unión  


 Capas de material: Acabado 
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3. Haga clic en el botón Añadir. 


 


Como puede ver, la pendiente lateral se extiende hasta que se encuentra con la 
superficie, que cambia a lo largo de la superficie del corredor. Dependiendo de la 
superficie en cada ubicación a lo largo del corredor, puede ser necesario un 
desmonte o un terraplén. Si se requiere un terraplén, se incluye una zanja de 3 pies 
(0,9 m) de ancho, según la instrucción. 


Ha terminado de definir la capa de material Acabado para el lado derecho de la 
plantilla. A continuación, definirá la capa de material Subnivel para el lado derecho. 


8e. Definir la línea de centro – capa Subnivel 
En el panel Editar plantilla de corredor, haga lo siguiente: 


1. En la lista desplegable Tipo de Instrucción, seleccione Desajuste/Elevación. 


2. Complete los campos Detalles de instrucción como sigue: 


 Desajuste/ elevación de origen:  1[LC] 


 Desajuste > Desajuste : -0 
El desajuste 0 asegura que el nuevo nodo Subnivel se encuentre directamente 
sobre o debajo del nodo 1[LC], dependiendo del valor Elevación. 


 Elevación > Elevación de incremento : -.5 
En la lista desplegable del botón Elevación, seleccione la opción Elevación de 
incremento. El signo menos que precede al número indica que  el nuevo nodo 
estará a 0,5 pie (0,15 m) bajo el nodo 1[LC]. 


 Nombre: LC Sub 
Escriba este nuevo código en el campo. 


 Capas de material: ninguna seleccionada 
Al no seleccionar una capa de material, puede asegurarse de que no se cree 
automáticamente una línea que conecte el nodo 1[LC] al nuevo nodo. 


3. Haga clic en el botón Añadir. 
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El nodo 7[LC Sub] recién creado representa la línea de centro para la capa de 
material Subnivel. 


 


 


8f. Definir la vía de tráfico derecha – capa Subnivel 
1. En la lista desplegable Tipo de Instrucción, seleccione Desajuste/Elevación. 


2. Complete los campos Detalles de instrucción como sigue: 


 Desajuste/ elevación de origen:  3[Vía de tráfico] 


 Desajuste > Desajuste : -0 


 Elevación > Elevación de incremento : -.5 


 Nombre: Vía de tráfico Sub 


 Capas de material: ninguna seleccionada 


3. Haga clic en el botón Añadir. 


El nodo 8[Vía de tráfico Sub] recién creado representa el borde derecho de la vía de 
tráfico derecha para la capa de material Subnivel. 
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8g. Definir la banquina derecha – capa Subnivel 
1. En la lista desplegable Tipo de Instrucción, seleccione Desajuste/Elevación. 


2. Complete los campos Detalles de instrucción como sigue: 


 Desajuste/ elevación de origen:  4[Banquina] 


 Desajuste > Desajuste : -0 


 Elevación > Elevación de incremento : -.5 


 Nombre: Banquina Sub 


 Capas de material: ninguna seleccionada 


3. Haga clic en el botón Añadir. 


El nodo 9[Banquina Sub] recién creado representa el borde derecho de la banquina 
para la capa de material Subnivel. 


 


A continuación, conectará los nodos de Subnivel recién creados con segmentos de 
línea. 


8h. Conectar los nodos – capa Subnivel 
En este procedimiento, definirá un segmento de línea para conectar los nodos 7[LC Sub] 
y 8[VT Sub]. 


1. En la lista desplegable Tipo de Instrucción, seleccione Conectar. 


2. Complete los campos Detalles de instrucción como sigue: 


 Nodo de origen:  7[LC Sub]  
Puede seleccionar el nombre del nodo en la lista desplegable o puede 
seleccionarlo en la vista gráfica de la plantilla. 


 Nodo de destino:  8[Vía de tráfico Sub] 


 Capas de material: Subnivel  
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3. Haga clic en el botón Añadir. 


 


A continuación, definirá un segmento de línea para conectar 8[VT Sub] y 9[Banquina 
Sub]. 


4. En la lista desplegable Tipo de Instrucción, seleccione Conectar. 


5. Complete los campos Detalles de instrucción como sigue: 


 Nodo de origen:  8[Vía de tráfico Sub] 


 Nodo de destino:  9[Banquina Sub] 


 Capas de material: Subnivel 


6. Haga clic en el botón Añadir. 


 


Ahora está listo para crear instrucciones para definir nodos y líneas en el lado 
izquierdo del nodo de 1[LC]. Para este tutorial, el lado izquierdo estará definido 
exactamente de la misma manera que el lado derecho, para que usted puede usar el 
comando Copiar instrucciones en espejo. 


8i. Copiar instrucciones en espejo desde el lado derecho de la 
plantilla al lado izquierdo 


1. Haga clic en el icono Copiar instrucciones en espejo  que se ubica en la parte 
superior del panel Editar plantilla de corredor. 
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Las instrucciones se copian "en espejo" al lado izquierdo de la plantilla, como se 
muestra aquí. 


 


2. Para ver cómo cambia la plantilla en relación con la superficie existente a lo largo del 
corredor, use el control deslizante que se ubica bajo la lista Instrucciones. 


La estación se indica en el campo ubicado a la izquierda. 


 
Esta plantilla está completa y ahora usted puede insertar plantillas adicionales al 
corredor, si es necesario. Sin embargo, para efectos de este tutorial no añadirá más 
plantillas.. En lugar de ello, el siguiente procedimiento explicará cómo puede editar 
una plantilla existente, cambiando una instrucción. 


3. En el panel Editar plantilla de corredor, haga clic en el botón Cerrar. 
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Paso 9. Editar una instrucción 
En este paso, editará una instrucción en la plantilla de corredor recién creada, 
redefiniendo el borde izquierdo de la vía de tráfico izquierda, basándose en una polilínea 
CAD que añadió al proyecto como línea de referencia con anterioridad en este tutorial. A 
medida que la polilínea CAD se mueve en relación con su desajuste hacia la línea de 
centro, también lo hace el desajuste para el borde izquierdo de la vía de tráfico izquierda. 


1. En la ventana Trimble Business Center, seleccione Vista > Explorador del 
proyecto, o haga clic en el icono Ver Explorador del proyecto  en la barra de 
herramientas. 


Aparecerá el panel Explorador del proyecto. 


 


2. En el panel Explorador del proyecto, expanda Corredor, haga clic con el botón 
secundario sobre el nodo de la plantilla de corredor  0+00.00, Plantilla 01, y 
seleccione Editar. 


Aparecerá el panel Editar plantilla de corredor. 


 


3. Cierre el panel Explorador del proyecto. 
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4. En la lista Instrucciones del panel Editar plantilla de corredor, haga doble clic en 
la instrucción 10[Vía de tráfico], o haga clic con el botón secundario sobre ella y 
seleccione Editar. 


 


Las propiedades para el nodo 10[Vía de tráfico] aparecen en la sección Detalles de 
instrucciones. 
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5. Haga clic en la lista desplegable del botón Desajuste y seleccione Línea 2D . 
Luego seleccione el nodo 2 en la vista gráfica. (Use la rueda del ratón para acercar, 
si es necesario). 


 


En el campo Desajuste aparecerá Polilínea CAD. 


 


6. Haga clic en el botón Guardar. 


El borde izquierdo de la vía de tráfico izquierda ahora depende de la ubicación de la 
polilínea CAD. 
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7. Para ver cómo cambia la plantilla en relación con la superficie existente y la polilínea 
CAD a lo largo del corredor, use el control deslizante que se ubica bajo la lista 
Instrucciones. 


 


 


Paso 10. Verificar la distancia máxima de muestreo 
Las plantillas de corredor crean una superficie que se corta en "rebanada" en los 
principales componentes horizontales y verticales de la alineación. Se crean cortes 
adicionales a intervalos (distancias de muestreo) definidas en las opciones de 
configuración del proyecto. En este paso, verificará que la configuración de distancias de 
muestreo esté correcta. 


1. Seleccione Proyecto > Configuraciones del proyecto. 
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2. En el diálogo Configuración del proyecto, seleccione Cálculos > Corredor en el 
panel de navegación. 


 


Podría reducir la Distancia máxima de muestreo para hacer que se creen más 
cortes, lo que daría como resultado una superficie más suave en las curvas 
verticales y horizontales. Sin embargo, para efectos de este tutorial no cambiará el 
valor predeterminado. 


3. Haga clic en el botón Cancelar. 


Ahora está listo para exportar el corredor. 


Paso 11. Exportar el corredor. 
En este paso, exportará el corredor recién creado como un archivo RXL. 


1. Seleccione Archivo> Exportar. O haga clic en el icono Exportar  en la barra de 
herramientas. 


2. En el panel Exportar, haga clic en la ficha Levantamiento. Luego seleccione 
Exportador de carretera RXL desde corredor en la lista. 
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3. En el campo Desajuste izquierdo, escriba 50. En el campo Desajuste derecho, 
escriba 35. 


Estas distancias aseguran que todo el ancho del corredor se incluya en la superficie 
exportada. 


 


4. En la sección Nombre de archivo, seleccione el botón Más  y seleccione la 
ubicación a la que desee exportar el archivo. 


5. Haga clic en el botón Exportar. 


Ha terminado de trabajar con el corredor, por lo que ahora puede cerrar el proyecto. 


6. Seleccione Archivo > Cerrar proyecto. 


Aparecerá el diálogo Guardar cambios. Si guardó el proyecto en una nueva 
ubicación o con otro nombre, puede hacer clic en Sí. De lo contrario, haga clic en 
No. 
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Acerca de este tutorial 
"Superelevación" es el banqueo de un camino o carretera a lo largo de una curva 
horizontal, de manera que los conductores puedan maniobrar por ella de manera 
cómoda y a velocidades razonables. A medida que aumenta la velocidad y las curvas 
horizontales se hacen más cerradas, se requiere una mayor relación de superelevación. 


En este tutorial, definirá una superelevación para una alineación utilizada para una 
carretera curva. Luego aplicará las propiedades de la superelevación al corredor como 
instrucciones de plantilla de corredor. Finalmente, definirá los parámetros de diferencia 
para la carretera a fin de asegurar que las diferencias de pendiente entre segmentos (por 
ejemplo, una calzada para vehículos y una banquina en una curva superelevada) se 
mantengan en un mínimo para fines de seguridad y comodidad a la velocidad 
contemplada en el diseño. 


Notas: 


 Para crear una superelevación como se describe en este tutorial, debe tener en 
ejecución el software Trimble Business Center con la licencia de producto Survey 
Advanced. Para comprobar la licencia de producto para su instalación, seleccione 
Ayuda > Acerca de Trimble Business Center y haga clic en el botón Licencia. Las 
funciones con licencia se muestran en la lista Funciones. 


 Si no sabe aún cómo trabajar con corredores y especificar instrucciones de plantillas 
de corredor, es recomendable que complete el tutorial Trabajar con corredores 
antes de iniciar este tutorial. 


 Si en cualquier momento necesita ayuda adicional mientras utiliza el software, 
presione F1 para ver la ayuda en línea. 


 


Paso 1. Abrir un proyecto. 
Para este tutorial, usará el archivo de proyecto Working with Superelevations.vce. Este 
proyecto contiene una superficie, una alineación horizontal y vertical, y un corredor. 


1. En la barra de menú de Trimble Business Center, seleccione Archivo > Abrir 
proyecto. O haga clic en el icono Abrir proyecto  en la barra de herramientas. 


2. En el diálogo Abrir archivo, vaya a C:\Trimble Tutorials\TBC\Projects\Working 
with Superelevations.vce y haga clic en Abrir. 


Si instaló el tutorial en una ubicación distinta a la predeterminada que se muestra 
aquí, navegue hasta esa ubicación. 
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El proyecto se abre en la ventana de Trimble Business Center. 


 


Nota: Esta figura muestra la Vista de plano con un fondo blanco. Su fondo puede 
estar en negro. Si desea cambiarlo a blanco, seleccione Herramientas > Opciones 
y seleccione Color de fondo: Blanco en el diálogo Opciones. 


El archivo de proyecto es de sólo lectura. Puede realizar los pasos del tutorial sin 
guardar el archivo del proyecto. Sin embargo, si sufre una interrupción mientras sigue el 
tutorial, puede guardarlo al seleccionar Archivo > Guardar proyecto como y guardarlo 
en ..\Mis documentos\Trimble Business Center, que es la ubicación típica para 
guardar archivos de proyectos en su computadora. Tras ello, puede volver a abrir el 
proyecto para proseguir con el tutorial más adelante. 


Paso 2. Aplicar una superelevación a la alineación 
La alineación horizontal de este proyecto incluye dos curvas en arco, una de las cuales 
incluye una espiral hacia adentro y una espiral hacia afuera. Para efectos de este 
tutorial, comenzará por aplicar una superelevación a las dos curvas para definir cambios 
de pendiente (banqueo) a lo largo de las mismas. Más adelante, añadirá instrucciones 
de superelevación a una plantilla de corredor. 


Nota: Para ver una descripción más detallada acerca de las superelevaciones, consulte 
el tema "Comprender las superelevaciones" en la ayuda en línea. 
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1. Seleccione Ver > Explorador del proyecto. 


2. En el Explorador del proyecto, expanda el nodo Alineaciones . Luego haga clic 
con el botón secundario en Carretera super y seleccione Editar. 


El panel Editor de Alineaciones aparecerá en el área inferior de la pantalla. 


 


3. Seleccione la ficha Superelevación en el lado izquierdo del panel Editor de 
alineaciones. 


Si es necesario, use el control de avance de tabulador para hacer que la ficha 
Superelevación aparezca y pueda ser seleccionada. 
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La lista desplegable ubicada en la parte superior de la ficha le permite seleccionar 
cada curva en la alineación horizontal, de modo que pueda definir parámetros de 
superelevación para ella. Para cada curva, se muestran la estación de inicio y el 
radio de curva. 


Comenzará por definir parámetros de superelevación para la primera curva en la 
alienación, que es una curva de arco simple. 


4. En la lista desplegable, seleccione la primera curva: 12+00,00, radio = 1000.000. 
Luego ingrese los siguientes parámetros: 


a. En el campo Pendiente transversal normal, asegúrese de que el valor sea -
2,00%. 


Este valor representa la pendiente transversal normal de la carretera cuando no 
está en superelevación y todas las curvas superelevadas de la alineación hacen 
referencia a él. Si hace cambios en este campo, afectarán a todas las curvas 
superelevadas. Si elimina la pendiente transversal normal, la superelevación se 
eliminará de la alineación. 


Nota: El valor de pendiente transversal normal que ingrese se usará en la vista 
Diagrama de superelevación. No reemplaza el valor de pendiente especificado en 
las instrucciones de plantilla de corredor. 


b. En el campo Superelevación máxima, escriba 6. 


Cuando hace avanzar el cursor a otro campo o presiona la tecla Tab, el valor 6 
cambia a 6,00%. Este es el máximo de superelevación para la curva, en 
términos de porcentaje de pendiente. 


El programa ingresa automáticamente valores para los campos en el lado 
derecho de la ficha, en base a una superelevación máxima de 6,00% y el hecho 
de que se trata de una curva en arco simple. Puesto que la curva no tiene espiral 
hacia adentro y espiral hacia afuera, el programa usa los parámetros de arco 
para las transiciones de superelevación. Esto significa que no hay transición 
desde la corona normal a la superelevación completa, y de regreso a la corona 
normal. El cambio es abrupto. Corregirá esto más tarde. 


 


c. En el campo Largo de curva vertical, introduzca 100. 
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Este valor especifica la longitud de la curva vertical parabólica que se aplicará en 
cada punto de transición de estación de inicio o término en la curva 
superelevada para suavizar la transición. El punto de transición es el PVI (punto 
vertical de intersección) para la curva vertical. El software traza además estas 
curvas verticales en el diagrama de superelevación en estos puntos de 
transición. 


Ahora está listo para definir parámetros para la segunda curva en la alineación 
horizontal, que es una curva en arco con una espiral hacia adentro y una espiral 
hacia afuera. 


5. En la lista desplegable, seleccione la segunda curva: 34+00,00, radio = 900,000. 
Luego ingrese los siguientes parámetros: 


a. En el campo Pendiente transversal normal, asegúrese de que el valor sea -
2,00%. 


b. En el campo Superelevación máxima, escriba 6. 


c. En el campo Largo de curva vertical, introduzca 100. 


Los valores que se ingresan automáticamente en los campos del lado derecho 
de la ficha se basan en una superelevación máxima de 6,00% y al hecho de que 
esta es una curva en arco con una espiral hacia adentro y una espiral hacia 
afuera. El programa usa los valores de espiral hacia adentro, arco y espiral hacia 
afuera para llenar los valores de estación de transición a la superelevación. 


 


 Comenzar transición de superelevación especifica la estación en que 
comienza la transición desde la corona normal a la superelevación máxima 
de 6% de pendiente. 


 Comenzar superelevación máxima especifica la estación en que comienza 
la superelevación máxima de 6% de pendiente. 


 Finalizar superelevación máxima especifica la estación en la que la 
superelevación máxima de 6% de pendiente y comienza la transición de 
regreso a la corona normal. 


 Finalizar transición de superelevación especifica el fin de la transición 
desde la superelevación máxima de 6% de pendiente de regreso a la corona 
normal. 
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Las cifras siguientes muestran la transición desde la corona normal a la 
superelevación máxima, y de regreso a la corona normal a través de una curva 
superelevada. 


Al aproximarse: 


Comienzo con corona normal. 


 
 


Transición a donde la vía exterior tiene una pendiente transversal cero (plana). 


  
 


Transición a donde se ha quitado la corona. 


  
 


Superelevación máxima. 


 
 


Al alejarse: 


Transición de regreso a donde se ha quitado la corona. 


  
 


Transición de regreso a donde la vía exterior tiene una pendiente transversal 
cero (plana). 


  
 


Regreso a la corona normal. 


 
 


Ahora verá la superelevación que ha definido en la vista Diagrama de 
superelevación. 
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6. Haga clic en el botón Diagrama de superelevación, ubicado en la parte superior de 
la ficha Superelevación.  Luego haga clic en la ficha Diagrama de superelevación 
y seleccione Mover al grupo de fichas anterior. 


 


El diagrama incluye líneas de cuadrícula sobre las que se muestra el perfil de la 
superelevación. Las líneas de cuadrícula verticales representan estaciones en la 
alineación. Las líneas de cuadrícula horizontales representan grados de pendiente. 
Las dos líneas de color, que forman el perfil de la superelevación, representan los 
bordes interior y exterior de la carretera. El diagrama se actualiza automáticamente a 
medida que hace cambios en la ficha Superelevación. 


Note: Puede cambiar la escala gráfica y la exageración vertical del diagrama en el 
diálogo Configuraciones del proyecto. 
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En el diagrama puede observar que la segunda curva (2 en la figura siguiente), que 
es un arco con una espiral hacia adentro y una espiral hacia afuera, incluye una 
transición desde la corona normal a la superelevación máxima, y de regreso a la 
corona normal. La primera curva (1 en la figura siguiente) no incluye espirales, por lo 
que el programa no especificó transiciones para ella. En lugar de ello, la curva 
cambia abruptamente desde la corona normal a la superelevación máxima. Corregirá 
esto en el paso siguiente. 


 


7. En la lista desplegable de la ficha Superelevación, seleccione la primera curva: 
12+00,00, radio = 1000,000 .Luego ingrese los siguientes parámetros: 


a. En el campo Comenzar transición de superelevación, introduzca 900. 


b. En el campo Finalizar transición de superelevación, introduzca 2100. 
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La primera curva muestra ahora una transición desde la corona normal a la 
superelevación máxima, y de regreso a la corona normal. 


 
Ha terminado de aplicar una superelevación a la alineación horizontal. A continuación, 
añadirá instrucciones de superelevación a una plantilla de corredor. 


Paso 3. Añadir instrucciones de superelevación a una 
plantilla de corredor 


1. En el Explorador del proyecto, expanda el nodo Corredores  y el nodo 2 Vía. 
Luego haga clic con el botón secundario en 0+000, Típica y seleccione Editar. 
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Aparecerá el panel Editar plantilla de corredor. 


 


La plantilla incluye nueve instrucciones que definen nodos para capas de material 
Acabado y Subnivel. 


 


Es necesario superelevar los nodos 2[BP] (1 arriba) y 5[BP] (2 arriba), que son los 
nodos izquierdo y derecho de borde de pavimento  para la capa Acabado. Por tanto, 
se debe insertar una instrucción de superelevación en la lista Instrucciones 
inmediatamente después de las dos instrucciones que definen estos nodos. Así, 
para comenzar, moverá la instrucción que define el nodo 5[BP] a directamente 
debajo de la instrucción que define el nodo 2[BP]. 


2. En la lista Instrucciones, haga clic en la instrucción que define el nodo 5[BP] y 
arrástrela a directamente debajo de la instrucción que define el nodo 2[BP]. 
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Observe que el nombre del nodo cambia de 5[BP] a 3[BP]. 


 


Ahora puede insertar una instrucción de superelevación inmediatamente después de 
la instrucción que define el nodo 3[BP]. 


3. Para insertar una instrucción de Superelevación para la capa Acabado, haga lo 
siguiente: 


a. Seleccione la instrucción que define el nodo 3[BP] en la lista Instrucciones. 


b. Haga clic en el icono Añadir instrucción  que se ubica en la parte superior 
del panel Editar plantilla de corredor. 


c. En la lista desplegable Tipo de Instrucción, seleccione Superelevación. 


d. En la lista Nodo de corona, seleccione 1[Carretera Super]. 


e. En la lista Nodo pivotal, seleccione 1[Carretera Super]. 


Este es el nodo alrededor del cual pivotará la pendiente superelevada. Este 
nodo se añade automáticamente a la lista Nodos seleccionados. 


f. Seleccione 2[EP] en la lista desplegable Seleccionar nodo y haga clic en el 
botón Añadir para añadir su selección a la lista Nodos seleccionados. 


Como alternativa, puede hacer clic en el campo Seleccionar nodo y luego 
seleccionar el nodo 2[EP] en la plantilla de la vista gráfica. 
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a. Seleccione 3[EP] en la lista desplegable Seleccionar nodo y haga clic en el 
botón Añadir ubicado directamente bajo él.. 


 
b. En la parte inferior del panel Editar plantilla de corredor, haga clic en el botón 


Añadir. 


La nueva instrucción de Superelevación se insertará en la lista Instrucciones. 


 


4. Use el control deslizante ubicado bajo la lista Instrucciones para ver la plantilla a 
todo lo largo de la alineación. 
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En la estación 9+00.00 comienza la transición hacia la superelevación máxima para 
la primera curva. La superelevación máxima se alcanza en la estación 12+00.00. 


 


En la estación 21+00.00, la plantilla regresa a la corona normal. En la estación 
25+60.00 comienza la transición hacia la superelevación máxima para la segunda 
curva. La superelevación máxima para la segunda curva se alcanza en la estación 
34+00.00. 
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Se ha superelevado satisfactoriamente el nivel Final de la plantilla. A continuación, 
aplicará la superelevación a la capa Subnivel. 


5. Para insertar una instrucción de Superelevación para la capa Subnivel (SN), haga lo 
siguiente: 


a. En la lista Instrucciones, haga clic con el botón secundario en la última 
instrucción de la lista (la instrucción que define el nodo 10[SN-ES]). 


b. Haga clic en el icono Añadir instrucción  que se ubica en la parte superior 
del panel Editar plantilla de corredor. 


c. En la lista desplegable Tipo de Instrucción, seleccione Superelevación. 


d. En la lista Nodo de corona, seleccione 8[SN-LC]. 


e. En la lista Nodo pivotal, seleccione 8[SN-LC]. 


Este nodo se añade automáticamente a la lista Nodos seleccionados. 


f. Seleccione 9[SN-ES] en la lista desplegable Seleccionar nodo y haga clic en el 
botón Añadir para añadir su selección a la lista Nodos seleccionados. 


g. En la lista desplegable Seleccionar nodo, seleccione 10[SN-ES] y haga clic en 
el botón Añadir. 


h. En la lista Nodos seleccionados,  haga clic con el botón secundario en 
1[Carretera Super] y seleccione Eliminar para eliminarlo de la lista. 


 


i. En la parte inferior del panel Editar plantilla de corredor, haga clic en el botón 
Añadir. 
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La nueva instrucción de Superelevación se insertará en la lista Instrucciones. 


 


6. Use el control deslizante ubicado bajo la lista Instrucciones para ver la plantilla a 
todo lo largo de la alineación. 


Observe que la pendiente superelevada de la capa Subnivel ahora coincide con la 
de la capa Acabado. 


 
Ahora está listo para definir parámetros de diferencia para asegurarse de que las 
diferencias de pendiente entre las vías de tráfico y las banquinas en las curvas 
superelevadas se mantengan en un mínimo para fines de seguridad y comodidad a la 
velocidad contemplada en el diseño. Para ver más información sobre parámetros de 
diferencia de pendiente, consulte "Ejemplos de parámetros de diferencia de pendiente" 
en la ayuda en línea. 
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Paso 4. Definir parámetros de diferencia de pendiente 
Como se muestra en la figura siguiente, cuando se está en la superelevación máxima de 
carretera en la primera curva, hay una diferencia de pendiente de un 10% entre la vía de 
tráfico izquierda (la vía exterior en la curva) y la banquina izquierda. Hay una diferencia 
de pendiente de un 2% entre la vía derecha (la vía interior en la curva) y la banquina 
derecha. 


 


Clave:  
1. Banquina -4%  
2. Incremento 10%  
3. Vía izquierda super 6%  
4. Vía derecha super -6%  
5. Incremento 2%  
6. Banquina -4%  


Ambas diferencias de pendiente son demasiado extremas para la velocidad contemplada 
en el diseño. En consecuencia, usted especificará un incremento mínimo y máximo que 
aplicar al corredor para cambiar estas diferencias de pendiente. Comenzará por definir 
las diferencias de pendiente máxima y mínima permisibles para la vía de tráfico y 
banquina derechas. 


1. En la lista Instrucciones, haga doble clic en la instrucción que define el nodo 4[ES]. 
O haga clic con el botón secundario en la instrucción y seleccione Editar. 
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Este nodo define la banquina derecha. En el modo de edición se muestran las 
propiedades para la instrucción. 


 


2. Haga clic en la casilla Definir parámetros de diferencia de pendiente. 


 


El valor Incremento máximo especifica la diferencia de pendiente máxima 
permisible entre la vía de tráfico y la banquina en el lado exterior de una curva. El 
valor Incremento mínimo especifica la diferencia mínima de pendiente entre la vía 
de tráfico y la banquina en el lado interior de la curva. Tenga en cuenta que para 
esta carretera la vía derecha es la vía interior en la primera curva y la vía exterior en 
la segunda curva. Así que el valor de Incremento máximo se aplicará a la vía y la 
banquina derechas en la segunda curva. El valor de Incremento mínimo se aplicará 
a la vía y la banquina derechas en la primara curva. 


3. En el campo Incremento máximo, escriba 4%. En el campo Incremento mínimo, 
escriba 0%. Luego haga clic en el botón Guardar. 


4. Use el control deslizante ubicado bajo la lista Instrucciones para ver la plantilla a 
todo lo largo de la alineación. 
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Observe que cuando alcanza la superelevación máxima para la primera curva, la 
diferencia entre la vía derecha (interior) y la banquina derecha es ahora 0%, basada 
en el 0% de Incremento mínimo especificado por usted. 


 


Cuando alcance la superelevación máxima para la segunda curva, la diferencia entre 
la vía derecha (exterior) y la banquina derecha es ahora 4%, basada en el 4% de 
Incremento máximo especificado por usted. 


 


Ahora está listo para definir los parámetros de diferencia de pendientes para la vía y 
banquina izquierdas. Para esta carretera, la vía izquierda es la vía exterior en la 
primera curva y la vía interior en la segunda curva. 


5. En la lista Instrucciones, haga doble clic en la instrucción que define el nodo 6[ES]. 
O haga clic con el botón secundario en la instrucción y seleccione Editar. 


 
6. Haga clic en la casilla Definir parámetros de diferencia de pendiente. 


7. En el campo Incremento máximo, escriba 4%. En el campo Incremento mínimo, 
escriba 0%. Luego haga clic en el botón Guardar. 


8. Use el control deslizante ubicado bajo la lista Instrucciones para ver la plantilla a 
todo lo largo de la alineación y así ver los parámetros de diferencia de pendientes. 


 


Paso 5. Ver la alineación en la Vista de ruta 3D 
Para ver una simulación de un recorrido por una carretera recién superelevada, siga 
estos pasos: 
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1. En la ventana Trimble Business Center, seleccione Vista > Alineación > Nueva 
vista de ruta 3D.  


 


2. Use el control deslizante ubicado a lo largo de la parte inferior de la ficha para ver la 
carretera a lo largo de la alineación. 


 


Ha terminado de trabajar con las superelevaciones, por lo que ahora puede cerrar el 
proyecto. 


3. Seleccione Archivo > Cerrar proyecto. 
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Aparecerá el diálogo Guardar cambios. Si guardó el proyecto en una nueva 
ubicación o con otro nombre, puede hacer clic en Sí. De lo contrario, haga clic en 
No. 
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